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Abstract ……..

This document is a software user manual for the MiDLE (Missile Detection in the Littoral 
Environment) software.  MiDLE, developed by DRDC over the last ten years, is a flexible, 
high-fidelity model designed to predict the detection performance of naval radar systems 
operating against anti-ship missiles in a littoral environment.  This version of the software was 
developed under contract to include a graphical user interface designed to make the software 
more accessible to non-expert users and some additional features.  The main features of the 
software are described.  Instructions for the installation and execution of the software are also 
provided. 

Résumé ….....

Le présent document est le guide d’utilisation du logiciel MiDLE (Missile Detection in the 
Littoral Environment [détection de missiles en région côtière]). Le MiDLE est un logiciel 
adaptatif à haute fidélité développé par RDDC au cours des dix dernières années. Ce modèle est 
conçu pour prévoir la capacité de systèmes radar navals de détecter des missiles antinavires en 
milieu littoral. Cette version du logiciel a été développée dans le cadre d’un contrat afin d’ajouter 
une interface graphique conçue pour faciliter l’accès au logiciel pour les utilisateurs non experts, 
ainsi que d’autres fonctions supplémentaires. Les fonctions principales du logiciel sont décrites 
dans le guide. Vous y trouverez également les instructions en vue de l’installation et l’exécution 
du logiciel. 
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1. Purpose

This document contains the Software User’s Manual (SUM) for the installation and operation of the of
the MiDLE (Missile Detection in the Littoral Environment) version 6.0 software. The purpose of this
document is to provide sufficient level of information to a non expert user to successfully install and
operate the software on a MS Windows based computer.

2. Background
MiDLE is a flexible, high fidelity model designed to predict the detection performance of naval radar
systems operating against anti ship missiles in a littoral environment. Particular emphasis is placed on
aspects of coastal environments that can significantly affect detection performance, such as
three dimensional variation in atmospheric refractivity and wind velocity, two dimensional variation in
surface clutter properties, sharp clutter differences at the land sea interface, etc. Particular emphasis is
also placed on radar system characteristics that will significantly affect detection performance in coastal
environments, such as clutter leakage through antenna side lobes and pulse compression range side
lobes, receiver saturation, eclipsing, range folded clutter returns, etc. MiDLE has the capability to
provide detection performance predictions for scenarios in simple generic environments as well as for
site specific scenarios. In the case of a site specific scenario, an accurate characterization of the
environment is required as an input to the model.1

3. Main Features
The main features of MiDLE consist of the specifications for modelling of the environment, RF
propagation and clutter, radar, target, jamming, signal processing, and for the specification of
calculations methods and the generation of calculation results.

3.1 Environment Specification
Refractivity structure specified by a single height profile or by three dimensional data in the
Hazard Prediction Assessment Capability Format (HPAC) produced by Environment Canada’s
Global Environment Multiscale (GEM) numerical weather prediction model,

Surface wind velocity specified by a single vector or as a two dimensional field derived from
wave model data or HPAC data,

Wave height specified as a single value or as a two dimensional field derived from wave
model data,

Swell direction specified as a single value or as a two dimensional field derived from wave
model data,

1Sections 2. to 3.8 adapted fromMissile Detection in the Littoral Environment (MiDLE), Alan Thomson, RAST, DRDC
Ottawa, April 11, 2011.



Elevated terrain based on Canadian Digital Elevation Data (CDED) or Digital Terrain Elevation
Data (DTED),

Terrain land cover type specified as a single value or as a function of space based on land
use database,

Precipitation structure specified by a single rain rate value, a single height profile (stratiform
precipitation), or by three dimensional weather radar data.

3.2 Propagation and Clutter Modelling
RF propagation using parabolic equation methods.

Sea and lake clutter:

o GIT reflectivity,

o Gaussian Doppler spectrum,

o K distribution statistics (amplitude).

Land clutter:

o Reflectivity from tables in Billingsley 2,

o Exponential AC Doppler spectrum plus DC component,

o Compound Weibull/exponential statistics (power).

Weather clutter:

o Three dimensional reflectivity factor field derived from defined precipitation
structure,

o Doppler spectrum based on raindrop size distribution, three dimensional wind field
derived from HPAC data, and turbulence,

o Rayleigh statistics (amplitude).

3.3 Radar SystemModelling
Electronically or mechanically (or hybrid) scanning antenna,

o sin x / x , Gaussian, cosecant squared, or user defined gain patterns,

o Clutter leakage through antenna gain pattern side lobes,

o Antenna gain pattern side lobe suppression.

Multiple burst transmission (electronic scan) varying frequency, pulse repetition frequency
(PRF), and number of pulses per burst.

Linear frequency modulation or phase coded pulse compression including:



o Range side lobes,

o Receiver frequency weighting,

o Eclipsing effects,

o Doppler effects.

Range folded clutter, with and without fill pulses,

Sensitivity time control,

Finite dynamic range (magnitude clipping, phase preserved).

3.4 Target Modelling
Constant or aspect dependent radar cross section.

Missile:

o g force constrained three dimensional trajectory,

o Tangential acceleration,

o Terminal manoeuvres,

o Swerling statistics.

Projectile:

o Ballistic trajectory,

o Swerling statistics.

3.5 Jamming Modelling
Stand off noise barrage.

3.6 Signal Processing
Envelope or square law detector,

MTI,

FFT (with or without time domain windowing), non coherent integration, or coherent
integration processing,

Binary integration (M of N detection).

3.7 Calculation Method
o 12900+ lines of IDL code,

o Modified Advanced Propagation Model (APM, SPAWAR):

o Spectral masking to determine propagation factor at the surface,

o Extraction of grazing angles,

o Binary output files,



o Parallel processing employing multiple CPUs.

o I,Q level modelling,

o Monte Carlo evaluation of detection thresholds and probabilities:

o Extreme value theory for low probabilities of false alarm.

3.8 Calculation Results
Probability of detection at locations of missile illumination:

o For each burst,

o For each dwell.

Various intermediate quantities such as propagation factors, clutter powers, target powers, I
and Q data, etc.

4. Software Components

MiDLE Version V6.0 consists of the following IDL procedure source files, organized into directories as
shown in the next sections.

4.1 Source Files
Directory Component filename Date modified Size (KB)

GUI calc_tick_value.pro 15/12/2011 2
calc_trajectory_data.pro 13/08/2012 1
check_files.pro 05/03/2013 7
common_block.pro 21/02/2013 3
common_defs.pro 24/03/2013 13
ConParamsControl.pro 20/02/2013 86
ContourColorsSelection.pro 08/03/2013 18
DetectionDisplay.pro 06/02/2013 9
DiagnosticsDisplay.pro 10/02/2013 41
EnvParamsControl.pro 24/03/2013 208
EP_event_handlers.pro 19/12/2012 5
EP_menu_handlers.pro 10/02/2013 51
EP_param_handlers.pro 25/03/2013 90
EP_plot_handlers.pro 10/02/2013 25
ExpertParamsControl.pro 25/03/2013 40
GenerateMF4Plot.pro 20/02/2013 72
GenerateMPPlot.pro 10/03/2013 60
GeneratePDPlot.pro 20/02/2013 71
GeneratePRMPlot.pro 20/02/2013 83
GeneratePSCPlot.pro 20/02/2013 109
GenerateSC4Plot.pro 20/02/2013 78
init_MiDLE.pro 10/03/2013 24
JammerParamsControl.pro 25/03/2013 45



Directory Component filename Date modified Size (KB)

GUI KML_generate.pro 10/02/2013 3
LC_colortable2.pro 18/02/2013 28
LC_lookupindex.pro 18/02/2013 4
line_legend.pro 19/12/2012 6
MiDLE_GUI_main.pro 10/03/2013 103
MissileParamsControl.pro 05/03/2013 62
PPI_DCHT_plot.pro 28/01/2013 13
PPI_REFF_plot.pro 10/03/2013 25
PPI_SCP_plot.pro 02/01/2013 15
PPI_SREF_plot.pro 10/03/2013 15
PPI_SWDR_plot.pro 20/02/2013 18
PPI_WCP_plot.pro 28/01/2013 15
PPI_WVDR_plot.pro 11/03/2013 20
PPI_WVEL_plot.pro 20/02/2013 19
PPI_WVHT_plot.pro 28/01/2013 11
process_dem.pro 16/03/2013 14
process_dtd.pro 04/01/2013 28
process_gnd_elevation.pro 30/11/2010 20
process_shapefile3.pro 17/02/2013 9
ProcessAntPattern.pro 14/12/2011 5
ProgramExecControl.pro 25/03/2013 84
ProjectileParamsControl.pro 05/03/2013 36
RadParamsControl.pro 23/02/2013 161
read_all_CDED.pro 16/03/2013 23
read_all_LANDC.pro 16/03/2013 24
reset_MiDLE.pro 05/03/2013 15
SignalParamsControl.pro 24/03/2013 21
threataxis_loc.pro 05/10/2011 2
vship_mesh_process.pro 14/12/2011 7
zoom_advance.pro 13/12/2012 2

MAIN AngleScale.pro 11/02/2012 6
AngleScaleJammer.pro 26/08/2011 4
APM_readOut.pro 26/07/2010 5
atten_0D.pro 08/08/2012 5
atten_1D.pro 08/08/2012 6
atten_3D.pro 08/08/2012 6
Ballistic.pro 07/02/2013 7
BBRef.pro 29/08/2011 5
betavar.pro 26/08/2011 3
bpfa.pro 06/09/2011 2
call_APM_DLL_F2surf.pro 25/03/2013 14
call_APM_DLL_F2surf_StandardOmni.pro 25/03/2013 12
call_APM_DLL_jammer.pro 25/03/2013 14
call_APM_DLL_target_graze.pro 25/03/2013 14



Directory Component filename Date modified Size (KB)

MAIN call_APM_F2surf_StandardOmni.pro 03/08/2012 12
cc.pro 26/08/2011 2
CircleSmooth.pro 25/03/2013 36
ClutterRangeWeights_SM.pro 06/03/2013 16
corkscrew2.pro 24/09/2011 2
define.pro 04/03/2013 55
DefineAntennaPattern.pro 20/12/2011 27
DefineJammerAntennaPattern.pro 26/08/2011 6
DefineReflectivity_mod.pro 06/03/2013 36
DefineScan.pro 09/02/2013 10
DefineTerrain.pro 22/03/2013 38
DefineTerrain_jammer.pro 22/03/2013 35
DefineWaves.pro 24/01/2012 19
DefineWbShapeParameter.pro 28/08/2011 20
DefineZ.pro 07/02/2013 14
dwellPd.pro 28/08/2011 3
EclipseWeights.pro 03/10/2011 2
erlang.pro 28/08/2011 1
FullScanIQ_SM.pro 06/03/2013 33
FUNC_RAYBINLUT.pro 28/08/2011 2
gammavar.pro 28/08/2011 3
gasattenrate.pro 28/08/2011 3
genchivar.pro 28/08/2011 2
jamF4.pro 09/08/2012 7
jammer.pro 14/08/2012 8
KShapeParameter.pro 28/08/2011 2
landspec_noTruncation.pro 28/08/2011 3
LimitMissile.pro 05/03/2013 8
LimitWeatherClutter.pro 05/03/2013 4
LKB002_stability_m.pro 28/01/2012 2
LKB002_stability_t.pro 28/01/2012 2
ll_arc_distance_array.pro 28/08/2011 4
loop_split.pro 18/10/2011 6
loop_split_SM.pro 06/03/2013 6
MakeFiles_APM_F2surf.pro 02/08/2012 14
MakeFiles_APM_jammer.pro 28/08/2011 15
MakeFiles_APM_missile_graze.pro 02/08/2012 15
map_2points_array.pro 28/08/2011 9
map_continents_modified.pro 28/08/2011 20
mergeLWKD.pro 24/08/2012 13
mgit.pro 07/10/2011 4
MiDLE.pro 25/03/2013 65
missileIQ_SM.pro 25/03/2013 38
MissileRCS.pro 07/02/2013 5
MissileStat.pro 12/10/2011 10



Directory Component filename Date modified Size (KB)

MAIN MissileStat_IQ.pro 12/10/2011 9
MissileTrajectoryE.pro 23/03/2013 13
MissileTrajectoryM.pro 23/03/2013 11
mkrand.pro 30/08/2011 2
mWbrand.pro 30/08/2011 2
noise.pro 06/03/2013 2
NSWC_blend.pro 24/08/2012 22
propagation_SM.pro 06/03/2013 35
query_grib_file.pro 24/08/2012 5
query_grib_record.pro 24/08/2012 4
RangeWeightingLFM.pro 18/11/2011 5
RangeWeightingMseq.pro 18/11/2011 5
read_grib.pro 24/08/2012 31
read_grib_record.pro 24/08/2012 3
readHPAC_SM.pro 06/03/2013 51
readHPAC_jammer_SM.pro 06/03/2013 49
scpow_SM.pro 06/03/2013 77
scpow_IQ_SM.pro 06/03/2013 68
seaspec_noTruncation.pro 30/08/2011 3
SetHeightLWKD.pro 26/09/2011 2
sidelobeLevel.pro 30/08/2011 2
singleM.pro 25/01/2012 6
splitTrajectory.pro 30/07/2012 9
sppar.pro 30/08/2011 5
STCclutter.pro 08/08/2012 2
STCmissile.pro 30/08/2011 2
tatten_0D.pro 07/08/2012 5
tatten_1D.pro 08/08/2012 6
tatten_3D.pro 08/08/2012 6
ThreshProb_SM.pro 22/03/2013 48
Trajectory_files.pro 25/03/2013 10
truncate_norm.pro 30/08/2011 2
URP_META_READER_MiDLE.pro 10/03/2013 14
WbShapeParameter.pro 12/10/2011 4
wcpow_0D_SM.pro 25/03/2013 25
wcpow_1D_SM.pro 25/03/2013 31
wcpow_3D_SM.pro 25/03/2013 42
WeatherSpec.pro 07/10/2011 11
weave3.pro 24/09/2011 4
Weibull.pro 30/08/2011 2
WindShear.pro 27/01/2013 49
WindShear_3D_SM.pro 06/03/2013 57



4.2 Data and Executable Files
MiDLE uses input from numerous data files during execution. It also calls several executable and library
files. These files must reside in a directory structure as shown below. The files must be copied from the
data CD of the MiDLE distribution. This is explained later in detail in the Software Installation and
Configuration section.

< ROOT DIRECTORY >
APM
DATA
ELDATA
GRIB
HELP
IMAGES
LC_GEOBASE
LCDATA
LWKD
OUTPUT

4.2.1 APM directory
The APM directory contains the APM dynamically linked library (DLL) and APM executable files. This
directory typically contain several versions of the APM program, for example SBAPM2305_x64.dll,
SBAPM2305.exe, etc. As the APM DLL was originally built from FORTRAN code, supporting files such as
DFFORT.DLL are also included. The APM directory must contain a subdirectory named ‘OUTPUT’ as this
is where the propagation factor and other calculation results are placed. This directory will normally
contain files of the type *.dat.

4.2.2 DATA directory
This directory contains miscellaneous data files used by MiDLE. These include object files for 3D mesh
surfaces, meteorological data files, missile radar cross section data, KML file template, etc. During
execution MiDLE may also store intermediate results of terrain elevation and land cover data in this
directory.

4.2.3 ELDATA directory
This directory contains terrain elevation data. The files contained in this directory are of the type *.el1
or *.el2, where the number specifies the corresponding DTED or CDED level. When ‘raw’ DTED or CDED
files are copied into this directory, MiDLE can convert them into *.el1 or *.el2 files which are in a format
that can be more quickly processed. Level 1 files use a 1201x1201 grid size whereas level 2 files use a
3601x3601 grid. The user is given the option to keep or delete the original files after processing is
complete.

4.2.4 GRIB directory
This directory as a minimum contains the wgrib.exe program and the cygwin1.dll file. The executable is
spawned by MiDLE to process wave data grib files.



4.2.5 HELP directory
This directory contains several text files that are read and displayed by MiDLE when the user clicks on
the different items contained in the ‘Help’ pull down menu.

4.2.6 IMAGES directory
This directory contains the various image files used by the program.

4.2.7 LC_GEOBASE directory
This directory is used as a convenient depository of ‘raw’ land cover files obtained from Natural
Resources Canada GeoBase website or from other sources. When these files are copied and pasted into
the LCDATA directory, they can be optionally processed by MiDLE .

Land cover data files are normally ‘shapefile’ set consisting of 3 parts; the shapefile itself (*.shp file), the
vector file (*.shx) and the database file (*.dbf). These files must all exist else MiDLE will issue a warning
and terminate processing. The projection file (*.prj) is not required.

4.2.8 LCDATA directory
This directory contains the land cover files used by MiDLE. When land cover shapefiles are placed into
this directory, MiDLE will detect them and ask for permission to process them. Processing normally
takes only a few seconds and an auxiliary pop up window displays the results. MiDLE will process all
shapefiles in this directory and optionally delete the original files when processing is complete. The
output files generated are of a similar in form to the terrain elevation data files and are of the type *.lc2.
As with terrain elevation data files, the number indicates the level, where a 1 corresponds to a
1201x1201 grid and a 2 corresponds to a higher resolution 3601x3601 grid.

4.2.9 LWKD directory
This directory contains the LWKD executable file LWKD.exe and several auxiliary files. LWKD is spawned
by MiDLE to calculate the low level refractivity profile. As the LWKD processing is parallelized, the
master process will create additional subdirectories within this directory, one for each slave process.
Each subdirectory will contain a copy of LWKD.exe and serves as a holder for the temporary files
generated.

4.2.10 OUTPUT directory
This directory contains all output files and intermediate files generated by MiDLE. Contrary to its name,
it also contains most of the input files used by the program. Hence its purpose is both for file input and
output during execution.

Several files exist in this directory of the form *_default.dat containing default data. These files should
never be deleted. The purpose of these default files is so that a user can run MiDLE immediately after it
is launched, without having to reconfigure any controls. The program will never overwrite any of these
default files and will issue a warning if the user attempts to do so.

1) BallisticPath_default.dat
2) ClutterRangeWeights_default.dat
3) dbz_default.dat
4) ExtractedSurfaceF4_default.dat



5) Jammer_default.dat
6) Lec_default.dat
7) MissileF4th_default.dat
8) MissilePath_default.dat
9) MissileRangeWeights_default.dat
10) SCAzBeamshapeLossData_default.dat
11) Sum_default.dat
12) Terrain_default.dat
13) ThreshProb_default.dat
14) WCAzBeamshapeLossData_default.dat
15) WCElBeamshapeLossData_default.dat
16) WeatherClutter_0D_default.dat
17) WeatherClutter_1D_default.dat
18) WeatherClutter_3D_default.dat

Each time MiDLE is launched, it creates the following files in the OUTPUT directory:

ProgExecCntlParams.sav – this file contains the default program execution global variables that
are used to initialize the Program Execution Control Panel (e.g. gNoPrecipitation,
gOldMissilePath, etc.) as well as the default file names listed above. This file is used by MiDLE to
restore all settings to the startup state when reset is pressed in the Program Execution Control
panel.

MiDLE_RuntimeInfo.sav – this file is created in the IDL development environment and holds the
program creation date, the operating system descriptor, the system architecture and the IDL
release version number. This file is restored in the runtime (RT) environment and its contents
can be viewed using the Help >About pull down menu.

ProgDefaultParams.spf – this file is created by MiDLE at program launch and stores all
parameters used. Since the total number of parameters is too large to fit into a single IDL
savefile, the *.spf file actually contains pointers to two savefiles; ProgDefaultParams_1.sav and
ProgDefaultParams_2.sav. The file is used to initialize the program to its startup state when
Program >Reset is pressed.

ProgDefaultFiles.sav – this file contains the default file name global values 1 to 18 listed above.
It is used to initialize MiDLE to its startup state when Program >Reset is pressed.

As MiDLE is highly parallelized, the program routinely creates files intended for slave processes during
its execution. These files are of the type:

1) *_loop_slave.pro procedure source file containing IDL code
2) *_loop_slave.sav executable save file
3) *_loop.dat data file

The ‘procedure’ file contains code intended for slave processes to execute and is only created in the IDL
development environment. The file is generated by calling the loop_split_SM.pro procedure. This
procedure compiles the source file, along with other IDL functions required for its execution into an



executable ‘save’ file. The ‘data’ file holds all data that slave process requires during execution. In the
RT environment, the executable file must exist in the OUTPUT directory.

If the diagnostic mode is selected, MiDLE creates the diagnostic.log file in this directory. The file is
appended while the program is in diagnostic mode until it reaches a limit of about 150 Kbytes. At this
point the user is asked if the log file should be deleted. The log file can be opened or deleted by the
user at any point as MiDLE will re create it if it does not exist.

In addition to the files mentioned above, MiDLE will place all files created by the user during execution.
These include missile trajectory waypoints, intermediate data files, *.kml or *.kmz files for importing
into Google Earth, and others. Care should be exercised by the user when deleting or modifying files in
this directory.

5. Software Installation and Configuration

5.1 Development Environment
For installation into the IDL development environment, the MiDLE V6.0 software requires that IDL
version 8.1 or greater is installed and licensed. The computer should be running the 64 bit version of
MS Windows Vista or MS Windows 7. Other operating systems have not been tested.

Create a root directory and copy the contents of CD #1 to it, then copy the contents of the data CDs. For
example, if the root directory created is C:/MiDLE/MiDLEV6/V6/ the directory structure should be as
shown below:

Figure 1: MiDLE Root Directory Structure

The files contained in each directory shown in Figure 1 is explained in Section 4.2.

If MiDLE source files are also included in software the distribution, it is recommended that a separate
workspace directory is created and the files copied to the appropriate folders:



Figure 2: MiDLE Workspace Directory Structure

During execution, MiDLE calls the Advanced Propagation Model (APM) dynamically linked library (DLL)
module. When the APM DLL module executes, it requires that a file called DFORRT.DLL is found. The
DFORRT.DLL file is located in the APM subdirectory and the ‘Path’ environment variable should include
it.

For example if the root directory structure is set up as shown in Figure 1, using the Control Panel, go to
Environment Variables and add the path as shown in Figure 3:

Figure 3: Setting the Path Environment Variable for DFORRT.DLL

The IDL project should be built as follows. Start IDL and create a new project, setting the workspace to
the directory defined previously. Note that in Figure 4 MiDLE_V6.1 is used as the project name is
completely arbitrary.



Figure 4: Creating the MiDLE_V6.0 Project

The project created should show the GUI and MAIN folders containing the MiDLE source files.

Figure 5: The Completed MiDLE_V6.0 Project

Expanding the GUI and MAIN folders shows the IDL procedures included in the project. A few
preliminary steps need to be completed before the MiDLE_V6.0 project can be built and executed.
Open the GUI folder and click on the common_defs.pro file. Modify the gDirectory and gWorkspace
global variables as shown in Figure 6.



Figure 6: Modifying the gDirectory and gWorkspace Globals

The gDRDC global variable should also be set as required to switch to the correct configuration. After
these changes are made, common_defs.pro should be saved and closed.

The MiDLE distribution may contain files in the GUI and MAIN folder that were included but are not
required to build the project. Right click on these files and select ‘Toggle Exclude From Build’. The
following Figure 6 shows this for the common_block.pro file which should exist in the project but should
always be excluded from the build. A small red square indicates that the file is excluded.

Figure 7: Excluding Files from the Project Build

The following list shows the files that may have been included in the MiDLE software distribution but
should be excluded from the project when it is built. (Some of these files can eventually be deleted
from the workspace but have been kept for testing and debugging purposes).

GUI
common_block.pro must exist in folder but always excluded from build
LC_colortable.pro
LC_convert.pro
vship_process.pro



MAIN
ClutterRangeWeights.pro
defineReflectivity.pro
FineTuneScenario03Trajectory.pro
FullScanIQ.pro
missileIQ.pro
MissileTrajectoryE_OLD.pro
noise_OLD.pro
propagation_OLD.pro
propagation.pro
readHPAC.pro
readHPAC_jammer.pro
scpow.pro
scpow_IQ.pro
thp_loop_slave.pro
ThreshProb.pro
wcpow_0D.pro
wcpow_3D.pro

As a final step before building the project, right click on the MIDLE_V6.0 folder and select Properties. In
the IDL Build Properties pane check and modify the following boxes:

o Use default IDL project build process
Restore save files from referenced projects
Compile Project files
Execute RESOLVE_ALL
Execute IDL Command after compiling project files:
.COMPILE svdfit, svdfunct, idlgrlegend__define, idlgrcolorbar__define
Create a save file
.\midle_init.sav

The above step ensures that the midle_init.sav file will be generated each time the project is built and
will include all of the required features needed for execution in the RT environment. Alternatively, the
midle_init.sav file can be built at the command line after the project is compiled as:

IDL > CD, C:\1DATA\WS_MiDLEV6.0
IDL > .COMPILE svdfit, svdfunct, idlgrlegend__define, idlgrcolorbar__define
IDL > SAVE, /ROUTINES, FILENAME = ’midle_init.sav’

The MiDLE_V6.0 project is now ready to be built. Right click on the MiDLE_V6.0 folder in the Project
Explorer pane and select ‘Build Project’. The IDL console will display messages as each source file and
the required IDL functions are compiled. At this point MiDLE is ready to run in the development
environment.



5.2 Runtime Environment
In the runtime (RT) environment, MiDLE is executed without an IDL license using the IDL Virtual Machine
Application supplied on the MiDLE distribution CD. This application executes the midle_init.sav file. The
IDL ‘save’ file contains the compiled MiDLE source and several IDL functions necessary for program
execution.

Copy the runtime files from the distribution CD to your computer. The directory structure should be as
shown in the following example:

Figure 8: Runtime Directory Structure

In the example of Figure 8, the runtime files are located in the C:\MiDLE\MiDLEV6\RT directory. Edit the
MiDLE_V6.ini initialization file as shown in the following figure, ensuring that the ‘DefaultAction’ and
‘Action’ parameters point to the correct savefile. For example, if the MiDLE savefile is midle_init.sav, set
these parameters as shown in Figure 9.

When this step is complete, a convenient shortcut to MiDLE_V6.exe can be created on the desktop to
execute the program.

Figure 9: Editing the MiDLE Initialization File

The executable and data files required by MiDLE (e.g. APM DLL, LWKD.exe, terrain elevation data, land
cover data, etc.) must be installed on the computer exactly as described in Section 4.2. The files must
reside in a directory structure as shown in Figure 1.



To execute MiDLE, double click on the MiDLE_V6.exe or start the program for the desktop shortcut. The
Virtual Machine displays the following IDL splash screen:

Figure 10: IDL Virtual Machine Splash Screen

6. Program Execution

6.1 Quick Starting the MiDLE GUI
The program entry point for MiDLE is the MiDLE_init procedure contained in the MiDLE_GUI_main.pro
file. The program can be started from the IDL DE command line as:

IDL >midle_init

or from the RT Virtual Machine application by clicking on the splash screen shown in Figure 10.

MiDLE takes a few seconds to initialize and displays the view shown in Figure 11. A proprietary message
is displayed briefly and removed as soon as the cursor enters the main view area. The area at the left
bottom half of the screen is for status messages below which the following information is displayed:

Radar longitude,
Radar latitude,
Threat type,
Threat longitude,
Threat latitude.

The area on the right bottom half of the screen is where the program displays colour bars for the various
plot quantities generated.



Figure 11: The MiDLE GUI

MiDLE contains default configuration files so that the program can be executed immediately by a non
expert user without the need to set any controls. This default configuration defines a scenario in which
the radar platform is located just off the Nova Scotia coast at the entrance to the Halifax harbour. The
threat (missile) launch position is located approximately 30 km to the north.

To run MiDLE using the default configuration, click on the top level ‘Program’ menu and select ‘Start’.
Several messages are displayed in the status window as MiDLE executes. The missile flight path
becomes visible shortly after the program starts. The missile executes a number of turns along its
trajectory.

The MiDLE GUI uses 3D object graphics. The main display area can be manipulated in several ways – it
can be zoomed, rotated and translated to optimize the view. A brief explanation of how to manipulate
the image is given in the Help >Keyboard controls menu. Figure 12 below shows a close up view of the
resulting image.

Figure 12: View of the MiDLE Display

Status message
window

Colour bar
display window

Main view areaTop level menus



The image generated by MiDLE shows the missile’s trajectory as a dotted white line. On the trajectory
line there are several white and red lines indicating the dwell probabilities of detection at various
ranges. Red lines represent locations where the probability of detection (PD) exceeds 90%, for white
lines the PD is less than 90% but greater than zero. The probability threshold for detection can be set in
the Control Parameters Control panel.

The visual display of PD is meant to give only a qualitative representation. MiDLE can also generate
quantitative results of the PD in the form of probability of detection vs. range and probability of
detection vs. time plots as shown in later sections.

At this point the user is encouraged to exercise the mouse and numerical keypad controls in
manipulating (e.g. zooming in and out, translating and rotating) the view. Advanced display controls are
explained in other sections of this document.

6.2 GUI Controls Overview
MiDLE has a wide range of GUI controls for specifying program execution, display, control, radar,
environment, signal processing, missile, projectile, jammer, signal processing and expert parameters.
These GUI controls are available using the top level menus and are described in the following sections.

6.2.1 The ProgramMenu
The program menu contains the following selections:

o Exit
o Reset
o Control
o Start

The ‘Start’ control should already be familiar – it is used to execute MiDLE. As we have seen in Section
6.1, it can be used to launch MiDLE using its default scenario without having to change any controls.
When the program parameters are configured for a new scenario, the ‘Start’ control is used to
commence execution.

The ‘Reset’ control re initializes MiDLE to its starting configuration and loads the default scenario. This
control is useful if the user gets stuck at any point and wants to reset the program without completely
exiting. To exit MiDLE altogether, click on the ‘Exit’ button. This destroys all internal objects and
pointers used by the program and closes the program in an orderly manner.

The ‘Control’ button opens the Program Execution Control panel as shown in Figure 13. This control
panel is used to instruct MiDLE which calculations to perform during its execution.



Figure 13: Program Execution Control Panel

When the PEC panel is first open it show the default scenario whereby MiDLE only restores previously
saved results. In this mode MiDLE still performs several operations that are always executed
irrespective of the control settings, such as displaying the missile trajectory, calculating scanning
characteristics and missile radar cross section, limiting missile data, etc.

Using the PEC panel the user can specify which calculations are to be performed as shown below. None
of the selections become active until the APPLY button is pressed

Enable or disable precipitation. If enabled, the user can optionally restore saved values
form a file or direct MiDLE to execute weather clutter power (WCP) calculations. If WCP
calculations are enabled, the user can direct the program to perform azimuth and elevation
beamshape loss calculations or simply restore these quantities from a file. The default WCP
files are in the OUTPUT directory and are named WeatherClutter_nD_default.dat where n is
0, 1 or 3. The beamshape loss data files are also located in the OUTPUT directory and are
namedWCAzBeamshapeLossData_default.dat andWCElBeamshapeLossData_default.dat.



Enable or disable a jammer. If enabled, the user can optionally restore saved values from a
file or direct MiDLE to execute jammer power calculations. (If a jammer is enabled and the
APPLY button is pressed in the PEC panel, a black cross appears on the view indicating the
location of the jammer). The default jammer power file is located in the OUTPUT directory
and named Jammer_default.dat.

Trajectory. If enabled, MiDLE will calculate the missile or projectile trajectory else it will
restore the trajectory data from a file. The default trajectory data files are located in the
OUTPUT directory and are named MissilePath_default.dat and BallisticPath_default.dat
respectively. (Another file worth mentioning here is MissilePath_default.kml which can be
imported into Google Earth for viewing. Generation of *.kml files is covered elsewhere in
this document).

Refractivity. If enabled, MiDLE will calculate the refractivity values else it will restore the
refractivity data from a file. The default refractivity data file is located in the OUTPUT
directory and namedM_default.dat.

Terrain. If enabled, MiDLE will calculate the terrain data else it will restore the terrain data
from a file. The default terrain data file is located in the OUTPUT directory and named
Terrain_default.dat.

Clutter Range Weights. If enabled, MiDLE will calculate the clutter range weights else it will
restore the clutter range weights from a file. The default clutter range weights data file
resides in the OUTPUT directory and named ClutterRangeWeights_default.dat.

Propagation. If enabled, MiDLE will calculate the propagation factors (PF) else it will restore
the PF values from a file. The default PF file is located in the OUTPUT directory and named
ExtractedSurfaceF4_default.dat.

Missile Propagation. If enabled, MiDLE will calculate the missile propagation factors (MPF)
else it will restore the MPF values from a file. The default MPF file is located in the OUTPUT
directory and namedMissileF4th_default.dat.

Missile Range Weights. If enabled, MiDLE will calculate the missile range weights else it will
restore them from a file. The default missile range weights file is located in the OUTPUT
directory and namedMissileRangeWeights_default.dat.

Weather Clutter Power. This control is available only when precipitation is enabled. If WCP
calculations are enabled, the azimuth and elevation beamshape loss widgets become
selectable.

Surface Clutter Power. If enabled, MiDLE will calculate the surface clutter power (SCP)
values else it will restore them from a file. If enabled, the user can optionally direct MiDLE
to calculate the azimuth beamshape loss else these values are restored form a file. The
default surface clutter power and azimuth beamshape loss data files are located in the
OUTPUT directory and named Sum_default.dat and SCAzBeamshapeLossData.dat
respectively.



Detection Thresholds and Probabilities. If enabled, MiDLE will calculate the detection
thresholds and probabilities else it will restore these values from a file. The default DT&P
data file is located in the OUTPUT directory and is named ThreshProb_default.dat.

The topmost widget of the Program Execution Control panel contains the ‘Scenario name’ entry. When
the control panel is first opened this entry shows ‘default’, indicating that currently the default scenario
is loaded and the default files are being used. If for example, the user selects ‘execute’ for the missile
trajectory, presses the APPLY button and starts MiDLE, the following message is displayed:

Figure 14: Program Execution Control Warning

The program was designed to protect the default files from being accidentally overwritten. The user
must select a new ‘scenario’ by typing its name into the Scenario Name widget. It is important to press
the <Enter> key after typing the scenario name.

After the scenario name is changed, it can be inspected for each function (e.g. Trajectory, Refractivity,
etc) by pressing the ‘S’ or select button. This opens up a file dialog box as shown in Figure 15.

Figure 15: Program Execution Control File Dialog Box

In this example the scenario name specified is ‘testcase_01’, hence the missile trajectory file will be
named as MissilePath_testcase_01.dat. The same modifier is subsequently applied to all other files;
M_testcase_01.dat, Terrain_testcase_01.dat, etc.



When MiDLE executes it will either create the new file specified or attempt to restore it. If this file has
not been created, the program will issue a warning and use the default file in its place.

Using the file dialog box shown in Figure 15, the user can specify other files to include from previous
calculations. In this manner not every function needs to be recalculated if it was already done so for a
previous test case. For example, if the refractivity values for the current test case are known to be the
same as for a previous one, the user can simply specify the previous file and select RESTORE.

Each function in the Program Execution Control panel has an associated ‘i’ or information button.
Pressing this button opens a window that gives a brief explanation of its function. For example, pressing
the ‘Scenario Name’ info button shows the message generated in Figure 16.

Figure 16: Example Program Execution Control Info Message

6.2.2 The Mode Menu
The mode menu contains the following selections:

o Normal
o Batch
o Diagnostic

The ‘normal’ mode of operation is set when MiDLE is started and this selection is checked in the Mode
menu. In this mode, MiDLE will complete a single run, display the results and stop. When the ‘batch’
mode of operation is selected and MiDLE is started, a file dialog box is opened as shown in Figure 17.



Figure 17: Program Execution Control Batch File Selection

The user can designate multiple files by pressing the <Ctrl> key and clicking on the files to be processed.
The batch files are of the type *.spf or saved parameter files. The files must be created prior to running
batch processing using the Parameters >Load function discussed in the next section. The *.spf files
basically contain a set of parameters that are restored before MiDLE is executed. In batch mode of
operation MiDLE will loop several times and process each file in turn. The output results are saved in
the OUPUT directory.

The ‘diagnostic’ mode is disabled when MiDLE first starts. When this button is clicked, the diagnostic
mode becomes enabled and the selection becomes checked. In diagnostic mode all output messages
generated are saved to a file in the OUTPUT directory named diagnostic.log. Each time MiDLE runs in
diagnostic mode it appends this file until the file size becomes very large. When it reaches 150 KBytes
the user is asked if the file should be deleted. When MiDLE runs and the diagnostic.log is not found it is
recreated.

When MiDLE is executed in diagnostic mode, it opens a window displaying all of the current parameters.
The user can inspect these parameters before committing to program execution. The parameters
display window blocks program execution until it is closed and therefore it is not advisable to run MiDLE
with both batch and diagnostic mode set.

An example diagnostic file is shown in Appendix A of this document.

6.2.3 The Parameters Menu
The parameters menu contains the following selections:

o Radar
o Control
o Environment
o Missile
o Projectile
o Signal
o Jammer



o Expert
o Save
o Load

6.2.3.1 Radar Parameters Control Panel
The radar parameters control is used to display the Radar Parameters Control (RPC) panel shown in
Figure 18. This control panel contains radar parameter widgets arranged in 3 columns. The RPC panel
shows only the first column when it is opened. The user can either expand the panel by dragging it or
access the other columns using the scroll bar. Three widgets, the Bursts Setup, the STC Maximum Range
and the Normalized Polar Angle Antenna Pattern Setup start sub control panels when clicked on. Note
that the latter one only becomes selectable only when the Polar Angle Pattern Type is ‘User’.

Most widgets have an ‘R’ or reset button to reinitialize them to the current values. All widgets have an
‘i’ or information button giving a brief description of the parameter. The APPLY button saves all changes
made for the current session and CLOSE closes the panel. The RESET button restores all widgets to their
default values.

Figure 18: Radar Parameters Control Panel

The RPC panel contains the following parameter controls:

Antenna height……………………............... range: 0.0 to 100.0 meters
Scan type …………………………………………… EE: electronic in vertical, electronic in azimuth

EM: electronic in vertical, mechanical in azimuth



MM: mechanical in vertical, mechanical in azimuth
Radar longitude ………………………………… range: 180.0 to 180.0 degrees
Radar latitude ………………….................. range: 90.0 to 90.0 degrees
Number of bursts ……………………………… range: 1 to 20
Number of fill pulses …………………………. range: 0 to 4
Pulse compression type …………………….. LFM, Mseq, PhaseCode or none
Azimuth angle pattern type ………………. sinx/x or Gaussian
Polar angle pattern type …………………… sinx/x, cosecant², Gaussian or User
Sampling frequency ………………………….. variable field: 4.0 MHz default
Antenna sidelobe suppression ………….. Azimuth: Yes or No

Elevation: Yes or No
Antenna sidelobe level ……………………… range: 120.0 to 120.0 dB
Phase code ………………………................. 10010011011101010010000100011100001
Phase code length …………………………….. range: 1 to 150 (35 default)
Azimuth extent of scan …………............ range: 5.0 to 180.0 degrees
Boresight azimuth angle ………………….. range: 0.0 to 360.0 degrees
Initial azimuth angle ………………………… range: 0.01 to 360.0 degrees
Boresight elevation angle ………………… range: 90.0 to 0.0 degrees
Initial beam spacing …………………………. variable field: 1.4947 degrees default
Range interval …………………………………… reference field: 37.475 meters default

Polar angle of beam axis ………………….. range: 90.0 to 0.0 degrees
Uncompressed pulse width ………………. range: 0.0 to 0.001 seconds
Pulse compression ratio ……………………. range: 1 to 600
Peak transmit power ………………………… range: 0.0 to 50000.0 Watts
Receiver noise figure …………………………. range: 1.0 to 10.0 dB
Receiver system losses ………………………. range: 1.0 to 10.0 dB
Receiver bandwidth ………………………….. range: 0.0 to 20.0 MHz
Noise bandwidth ………………………………. range: 0.0 to 20.0 MHz
Receiver system gain ………………………… range: 10.0 to 10.0 dB
Receiver system temperature …………… range: 0.0 to 500.0 degrees K
Receiver saturation level …………………… range: 30.0 to 90.0 dB

Frequency domain weighting ……………. Taylor, Hamming or Rectangular
Parameter for Taylor weighting …........ range: 0 to 20
Desired sidelobe level ……………............. range: 80.0 to 10.0 dB
STC curve exponent …………………………… range: 0 to 10
STC gain offset …………………………………… range: 3.0 to 3.0
Antenna diameter in azimuth dir ………. range: 0.0 to 10.0 meters
Antenna diameter in elevation dir …….. range: 0.0 to 10.0 meters
Antenna polarization ………………………… Vertical (V) or Horizontal (H)
Antenna rotation rate ……………………….. range: 0.0 to 100.0 rev/min
Time domain weighting …………………….. Hanning, Hamming or Rectangular

The RPC panel displays the radar platform’s current latitude/longitude position. In the MiDLE GUI the
radar position can be changed by holding down the <Alt> key and clicking on the new position in the



view. The ‘Radar longitude’ and ‘Radar latitude’ widgets will be updated automatically with the new
latitude/longitude values selected. After pressing APPLY the display will be regenerated with the radar
shown at its new position.

In this manner the user can place the radar at any geographic location within the view. For example if
the new radar position’s elevation is greater than zero meters (above sea level), MiDLE issues a warning
and asks for permission to continue. This warning message is shown in Figure 19.

Figure 19: Radar Parameters Control Panel Warning Message
Clicking on the ‘Burst Setup’ button in the RPC panel opens the sub control panel shown in Figure 20.
The default number of bursts is 4, therefore this sub control panel contains only 4 columns, one for each
burst. The maximum number of bursts that can be specified is 20. Parameters shaded gray in the sub
control panel (e.g. pulse repetition interval and wavelength) cannot be edited as their values are
functions of other parameters. The currently selected parameter is coloured blue.

Figure 20: Burst Setup Sub Control Panel

When the Polar Angle Pattern Type is set to ‘User’, the Normalized Polar Angle Antenna Pattern SETUP
button becomes selectable. Clicking on this button opens the sub control panel shown in Figure 21.



Figure 21: Polar Angle User Pattern Sub Control Panel

Clicking on the STC Maximum Range button opens the sub control panel shown in Figure 22.

Figure 22: STC Maximum Range Sub Control Panel

6.2.3.2 Control Parameters Control Panel
The control parameters button is used to display the Control Parameters Control (CPC) panel shown in
Figure 23. This control panel contains widgets used initialize various parameters arranged in three
columns. The CPC panel is opened showing only the first column. The user can either expand the panel
by dragging it or access the other columns using the scroll bar.

Most widgets have an ‘R’ or reset button to reinitialize them to the current values. All widgets have an
‘i’ or information button giving a brief description of the parameter. The APPLY button saves all changes
made for the current session and CLOSE closes the panel. The RESET button restores all widgets to their
default values.



Figure 23: Control Parameters Control Panel

The CPC panel contains the following parameter controls:

Range step ……………………............................................................ range: 0.0 to 100.0 meters
Maximum range ………………………………………………………………………. range: 10000.0 to 100000.0 m
Maximum propagation angle ………………………………………………….. range: 5.0 to 30.0 degrees
Number of characteristic points for antenna pattern ………………. range: 0 to 30
Height grid spacing for propagation calculations ……………………. range: 0.0 to 10.0 meters
Range grid spacing for propagation calculations …………………….. range: 0.0 to 1000.0 meters
Probability of detection threshold ……………………………………………. 0.0 to 1.0
Number of CPUs ……………………………………………………………………….. range: 1 to
Target type ………………………………………………………………………………..Missile or Projectile

Refractivity profile range step …………………….…………………………….. range: 0.0 to 5000.0 meters
Refractivity profile 2nd derivative threshold ………………………………. range: 0.0 to 0.1
Refractivity profile test height ………………………………………………….. range: 0.0 to 100.0 meters
Refractivity profile smoothing iterations ………………………………….. range: 0 to 500
Azimuth beamshape loss …………………………………………………………. On or Off
Number of azimuth angles per beamwidth ……………………………… range: 1 to 10
Fraction of power for Doppler spectra ……………………………………… range: 0.0 to 1.0
Number of folded range intervals for clutter calculations ……….. range: 1 to 10
Maximum angular samples for WCP calculations …………………… range: 1 to 20

Maximum polar angle for WCP integration ……………………………… range: 0.0 to 2.0 degrees



Number of samples per group in EVT ……………………………………….. range: 0 to 2000
Sample limit value ……………………………………………………………………. range: 0.0 to 5000000.0
Number of points for range weighting functions …………………….. range: 1 to 200
Max heights grid points for APM calculations ………………………….. range: 1 to 3000
Propagation Model ………………………………………………………………….. APM, MRADAR or Other
APM calling method …………………………………………………………………. DLL or EXE
Refractivity profile blending method ………………………………………… DRDC or NSWC
Max height resolution for blending profiles ……………………………… 0.0 to 2.0 meters

The Maximum Range control is important as it is used to define the radar range and the extent of the
view displayed by MiDLE. Selecting a different range and pressing APPLY will regenerate the view.

The Target Type widget is ‘Missile’ by default and this is displayed in the information window of the
MiDLE GUI shown in previously in Figure 11. The user can access the Missile Parameters Control (MPC)
panel. If the target type is changed to ‘Projectile’ and the APPLY button is pressed, the missile
parameters are no longer selectable and the user can only access the Projectile Parameters Control
(PPC) panel. If the MPC panel is currently open and the target type is changed to ‘Projectile’, the MPC
panel is closed as it is no longer applicable. Similarly if the PPC panel is currently open and the target
type is changed to ‘Missile’, the PPC panel is closed.

6.2.3.3 Environment Parameters Control Panel
The environment parameters button is used to display the Environment Parameters Control (EPC) panel
shown in Figure 24. This control panel contains environmental parameter widgets arranged in four
columns. The EPC panel is opened showing only the first column. The user can either expand the panel
by dragging it or access the other columns using the scroll bar. Six of the widgets open sub control
panels when clicked on:

Power ratio adjust factor,
Land cover type,
Bulk met parameters (single point data),
Refractivity profile (no single point data),
Reflectivity factor profile,
Wind velocity profile for weather clutter.

Most widgets have an ‘R’ or reset button to reinitialize them to the current values. All widgets have an
‘i’ or information button giving a brief description of the parameter. The APPLY button saves all changes
made for the current session and CLOSE closes the panel. The RESET button restores all widgets to their
default values.



Figure 24: Environment Parameters Control Panel with Precipitation Enabled

The EPC panel contains the following parameter controls:

Sea state …………………….................................................. range: 0 to 9
Average wave height ………………………………………………….. range: 0.0 to 10.0 meters
Surface wind speed over water……………………………………. range: 0.0 to 30.0 m/sec
Surface wind speed over land ……………………………………… range: 0.0 to 30.0 m/sec
Wind direction ...…………………………………………………………. range: 0.0 to 360.0 degrees
Swell direction …………………………………………………………….. range: 0.0 to 360.0 degrees
Surface air temperature ……………………………………………… range: 40.0 to 40.0 °C
Surface atmospheric pressure …………………………………….. range: 800.0 to 1200.0 mbar
Surface relative humidity …………………………………………….. range: 0.0 to 100.0 %
Sea surface salinity ……………………………………………………… range: 0.0 to 100.0 g/Kg

Land cover data ………………………………………………………….. Available or Unavailable
HPAC data ………………………………………………………………….. range: 0 to 20
HPAC file …………………………………………………………………….. text field
Upper level measurement height ……………………………….. range: 0.0 to 10.0 meters
Wind speed measurement height ……………………………….. range: 0.0 to 100.0 meters
Maximum measurement height …………………………………. range: 0.0 to 2000.0 meters
Refractivity profile definition ………………………………………. Use LWKD or Use Dataset
Refractivity profile merge ……………………………………………. Merge or No Merge
Relative humidity over water ……………………………………… range: 90 to 100 %



Rain rate …………………………………………………………………….. range: 0 to 200 mm/Hr
Maximum height for precipitation …………………………….. range: 100 to 20000 meters
Surface CAPPI file ………………………………………………………. text field
1 Km CAPPI file ………………………………………………………….. text field
4 Km CAPPI file …………………………………………………………… text field
ECHOTOPS file …………………………………........................... text field
Wave field definition ………………………………………………….. 2D or Wind
Wave file …………………………………………………………………….. text field
Wave forecast hour ………………………………...................... range: 0 to 10

Precipitation field definition ……………………………………….. 3D, Profile or Constant
Vertical resolution for Z field ……………………....…………….. range: 100.0 to 1000.0 meters
Echotop reflectivity factor value …………………………………. range: 50.0 to 50.0 dBZ
Rate of reflectivity factor decrease ………………............... range: 0.03 to 0.0 dBZ/m
Z R power law coefficient …………………………………………… range: 0.0 to 600.0
Z R power law exponent …………………………………………….. range: 0.0 to 3.2
Turbulence spectrum width ………………………………………… range: 0.0 to 3.0 m/sec
Wind field definition for weather clutter ……………………… 3D, Profile or Constant
Wind speed for weather clutter …………………………………… range: 0.0 to 30.0 m/sec
Wind direction for weather clutter ……………………………… range: 0.0 to 360.0 degrees

Figure 24 shows the EPC panel for the case when precipitation is enabled. Some of the widgets become
desensitized when precipitation is disabled such as rain rate, maximum height for precipitation, etc.

The land cover type button becomes selectable when land cover data is unavailable as shown in the
above figure. In this case the user can click on the land cover type SELECT button to specify a land cover
type that will be used everywhere. The land cover type selection window is shown in Figure 25. The
default land cover type is ‘Built up or non vegetated’ (index 25).



Figure 25: Land Cover Type Selection Sub Panel

The bulk meteorological parameters button becomes sensitive when there is no HPAC data available
(the HPAC data slider widget is set at 0) and the refractivity profile definition is ‘Use LWKD’. Clicking on
the ‘Bulk met parameters’ button opens the sub control panel shown in Figure 26.

Figure 26: Bulk Meteorological Parameters Sub Panel



The Bulk Meteorological Parameters (BMP) control panel opens the Upper Air Profile Parameters
Control sub sub panel when the SELECT button is clicked. This is shown in Figure 27.

Figure 27: Upper Air Profile Parameters Sub Sub Panel

When HPAC data is available (e.g. the HPAC Data slider widget is set to a value other than 0), clicking on
the Refractivity Profile SELECT button in the EPC panel opens the Refractivity Profile Control sub panel
shown in Figure 28.

Figure 28: Refractivity Profile Control Sub Panel



Clicking on the Reflectivity Factor Profile widget SELECT button in the EPC panel opens the sub panel
shown in Figure 29.

Figure 29: Reflectivity Profile Control Sub Panel

Clicking on the Wind Velocity Profile for Weather Clutter widget SELECT button in the EPC panel opens
the sub panel shown in Figure 30. Note that this selection is only available if the wind field definition is
‘Profile’.

Figure 30: Wind Velocity Profile Control Sub Panel

Clicking on the Power Ratio Adjustment Factor widget SELECT button in the EPC opens the AC/DC Power
Ratio Adjustment Control sub panel shown in Figure 31.

Figure 31: Power Ratio Adjustment Control Sub Panel



6.2.3.4 Missile Parameters Control Panel
The missile parameters control is used to display the Missile Parameters Control (MPC) panel shown in
Figure 32.

Figure 32: Missile Parameters Control Panel

The MPC panel contains the following parameter controls:

Maximum centripetal acceleration …………………….......... range: 1.0 to 10.0 g
RCS data format …………………………………………................ Aspect or Constant
RCS file ……………………………………………………………………….. text field
Nose on radar cross section ………………………………………. range: 0.01 to 2.0 m²
Swerling model ………………………………………………………….. range: 0 to 4

The MPC panel is more complex than any of the other control panels as it is used to define the missile
trajectory waypoints as well as the missile parameters. When MiDLE is started, the MPC shows the



waypoints of the default missile flight path. The missile waypoints can be configured using the INSERT
and DELETE buttons as well as by clicking the mouse in the main view area. The waypoints can of course
also be edited manually in the MPC waypoints table.

Help on how to use the MCP panel is available by clicking on Help >Parameters >Missile. The following
paragraphs and figures illustrate a typical case where a new set of waypoints are defined using the
existing waypoints table.

Zooming in and rotating the main view area produces the image shown in Figure 33. In this figure
waypoint #3 was selected by highlighting it. Notice that the waypoint designator circle in the view
changes to red indicating its location. At this waypoint the height of the missile is 65 meters. Changing
the height field to 650 meters and pressing <Return> changes the view correspondingly. The location of
the waypoint relative to the ground is indicated by a white line.

Figure 33: Changing the Missile Height at a Waypoint

In the same manner the missile latitude, longitude and velocity values at any waypoint can be modified
by entering values directly in the table. A much faster method to designate waypoints to define a new
flight path is by using the left mouse button and the <Shift> key.

In the following example a new set of waypoints is defined while keeping the missile launch position and
destination positions the same. Note that in this case the missile destination (target) is the same as the
radar’s location but this is not necessarily the case each time.

To define a new set of waypoints between the missile launch and destination positions we first delete all
intermediate waypoints. This can be accomplished by clicking on waypoint #1 and dragging the cursor
down to waypoint #16, effectively selecting (highlighting) these waypoints. Once selected, the
waypoints can be deleted together by pressing the DELETE button. The waypoints table and the
resulting image are shown in Figure 34.



The waypoints table in Figure 34 now shows only two waypoints and the missile trajectory is a straight
line connecting the launch and destination points. The path length box shows a new path length of
approximately 30 km.

Figure 34: Deleting Intermediate Missile Waypoints

Coordinates of the missile launch or destination (target) positions can be changed by highlighting the
waypoint, pressing the <Shift> key and clicking anywhere in the view. Note that neither of these
waypoints can be deleted as the missile trajectory always requires a minimum of two waypoints.

In Figure 33 the missile launches from a height of 90 meters and descends to 3 meters on its way to the
target. The white trajectory line is not visible at certain points because of the intervening terrain. The
missile’s trajectory must therefore be adjusted to so that the missile either flies around obstacles and
elevated land features or flies over them. The terrain elevation is colour coded so that green areas are
of lower elevation than red regions.

Insert a new waypoint by clicking on the waypoint after which the new waypoint will appear. In this
example we select waypoint #0 (the missile launch position) and click on the INSERT button. A new
waypoint is added with the same parameters as waypoint #0 as illustrated in Figure 35.

Figure 35: Adding Intermediate Missile Waypoints

Select new waypoint #1 in the view using the left mouse button while holding down the <Shift> key.
The view changes to show the location of the new waypoint and the waypoints table shows the



waypoint’s latitude/longitude position. The height and velocity field values remain unchanged. If the
position of the new #1 waypoint needs to be adjusted slightly, repeat the procedure by holding the
<Shift> key and clicking on the view.

For a finer adjustment of the new waypoint position, the view can be zoomed and rotated and the
waypoint latitude/longitude values can be edited manually. The underlying terrain elevation grid uses
level 2 data arranged in a 3601x3601 array. As each cell covers approximately 1° of latitude and
longitude the resolution is therefore limited to approximately 0.0003 degrees using this method. If fine
tuning of the waypoint’s position is required it must be done manually by modifying the table values.

Figure 36 below shows the resulting plot with two waypoints added after the missile launch waypoint
#0. The view has been zoomed and rotated for clarity.

Figure 36: Example With Two New Missile Waypoints Added

The default waypoints can be reconfigured by pressing the RESET button. When all new missile
waypoints have been defined, the configuration can be saved for the current session by pressing the
APPLY button. Once APPLY is pressed the RESET button will no longer return the waypoint values to the
default (start up) values since the new configuration applied now becomes the default setting. To reset
the original configuration click on Program >Reset.

The DISPLAY button toggles the waypoint designator circles on and off as well as the projection lines
extending from the waypoint to the ground surface. This feature allows for de cluttering of the display
if required.

The SAVE and LOAD buttons open a file dialog box for saving and restoring a set of defined waypoints.
The data is saved/loaded as *.wpt files. The CLOSE button closes the MPC panel.

When new missile waypoints are defined and applied for the current session, MiDLE will automatically
configure the Program Execution Control panel discussed in Section 6.2.1. The program will set the
EXECUTE command for the following functions:

Trajectory,
Missile Propagation,
Missile Range Weights,



Surface Clutter,
Detection Thresholds and Probabilities,

The above quantities, as a minimum, must be recalculated each time a new set of missile waypoints is
defined.

6.2.3.5 Projectile Parameters Control Panel
The Projectile Parameters Control (PPC) panel only becomes selectable when the Target Type is set to
‘Projectile’ in the Control Parameters Control (CPC) panel discussed in Section 6.2.3.2. The PPC panel is
shown in Figure 37.

Figure 37: Projectile Parameters Control Panel

The PPC panel contains the following parameter controls:

Launch location longitude ……………………....... range: 180.0 to 180.0 degrees
Launch location latitude ……………………………. range: 90.0 to 90.0 degrees
Destination longitude ……………………………….. range: 180.0 to 180.0 degrees
Destination latitude ………………………………….. range: 90.0 to 90.0 degrees
Launch height ……………………………………......... range: 0.0 to 30.0 meters
Launch velocity magnitude ……………………….. range: 10.0 to 2000.0 m/sec
RCS format data …………………………………....... Constant or Aspect
Radar cross section ………………………………...... range: 0.01 to 2.0 m²



The PPC panel contains only two ‘waypoints’, namely the projectile launch and destination
latitude/longitude positions. The projectile destination (target) position coincides with the position of
the radar by default. The main view area changes to show a single line connecting these positions. This
line is shown for reference only and does not represent the projectile flight path. MiDLE will generate
the projectile flight path from the input parameters (e.g. launch height and velocity, etc.) as it executes
and display it in the view. Figure 38 shows the calculated projectile trajectory.

Figure 38: Projectile Trajectory View

6.2.3.6 Signal Processing Parameters Control Panel
The signal processing parameters control is used to display the Signal Processing Parameters Control
(SPPC) panel shown in Figure 39.

Figure 39: Signal Processing Parameters Control Panel



The SSPC panel contains the following parameter controls:

Detection losses ………………………………………………. range: 0.0 to 10.0
M parameter for M of N detection processing … text field
Dwell probability of false alarm ………………………. 1.0e 7 to 1.0e 5
Probability of false alarm ………………………………… reference field
Number of MTI pulses ……………………………………… range: 1 to 30
Processing type ………………………………………………. FFT, Coherent or Non coherent integration
Detector type ………………………………………………….. Square law or Envelope

6.2.3.7 Jammer Parameters Control Panel
The jammer parameters control is used to display the Jammer Parameters Control (JPC) panel shown in
Figure 40.

Figure 40: Jammer Parameters Control Panel

The JPC panel contains the following parameter controls:

Jammer transmit power ……………………………………….. range: 100.0 to 5000.0 W
Jammer transmit antenna gain …………………………….. range: 0.0 to 30.0 dB
Jammer centre frequency …………………………………….. range: 1.0 to 15.0 GHz
Jammer 6 dB bandwidth ………………………………………. range: 1.0 to 20.0 MHz
Jammer azimuth angle gain pattern type …………….. sinx/x or Gaussian



Jammer polar angle gain pattern type …………………. sinx/x, Gaussian or User
Jammer longitude ………………………………………………… range: 180.0 to 180.0 degrees
Jammer latitude ……………………………………………………. range: 90.0 to 90.0 degrees

Antenna diameter in the azimuth direction ………..... range: 0.0 to 1.0 meter
Antenna diameter in the elevation direction ………… range: 0.0 to 1.0 meter
1 way 3 dB azimuth angle beamwidth …………………. range: 1.0 to 45.0 degrees
1 way 3 dB polar angle beamwidth ……………………… range: 1.0 to 45.0 degrees
Boresight azimuth angle ………………………………………. range: 0.0 to 360.0 degrees
Polar angle of beam axis ………………………………………. range: 90.0 to 0.0 degrees
Jammer antenna height ……………………………………….. range: 0.0 to 3000.0 meters
Jammer antenna polarization ……………………............ Vertical or Horizontal

The Jammer Parameters Control panel can only be selected if the jammer is enabled in the Program
Execution Control panel. When enabled, the jammer is represented by a black diamond symbol. The
jammer symbol contains a pointer indicating the antenna boresight azimuth angle. In the default
scenario the jammer’s position is the same as the missile launch position. The antenna height is 100
meters and the jammer antenna points south.

The jammer location can be changed via the JPC panel GUI or by holding down the <Shift> key and
clicking anywhere within the view. In this case however changes only becomes effective after the APPLY
button is pressed. Figure 41 shows the resulting view with the jammer antenna boresight azimuth angle
changed to 270° and the height set at 500 meters. As with the missile waypoints, a projection line to
the ground surface is used to preserve the spatial orientation of the jammer.

Figure 41: The Jammer Symbol

Boresight
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6.2.3.8 Expert Parameters Control Panel
The expert parameters control is used to display the Expert Parameters Control (EXPC) panel shown in
Figure 42.

Figure 42: Expert Parameters Control Panel

The EXPC panel contains the following parameter controls:

V101 …………………………………………………………. On or Off
V2Eclipse ………………………………………………….. On or Off
Wallops …………………………………………………….. On or Off
iData ………………………………………………………… On or Off
SADM ……………………………………………………….. On or Off
Generate KML file ………………………................ On or Off
Eclipsing loss …………………………………………….. Restore or Execute
Full scan IQ ……………………………………………….. On or Off
Full scan IQ azimuth beamshape loss ……….. Restore or Execute
Full scan IQ azimuth and range sum …………. Restore or Execute
Length interval …………………………………………. range: 0.0 to 1.0 degrees



6.2.4 The Display Menu
The display menu controls the various graphic objects presented in the main view area and contains the
following selections:

o Threat
o Radar
o Terrain
o Ocean
o Symbols
o Background
o Visibility
o Platform
o Detection
o Overlay

6.2.4.1 Threat Display Control
The threat display control is used to control how the threat (either missile or projectile) trajectory is
displayed in the view. By selecting Threat >Trajectory the following options are available:

o Enable
o Color
o Style

When MiDLE is first started the user can select the ‘Enable’ button to display the default missile
trajectory as MiDLE initially always loads the default scenario. When the ‘Enable’ button is clicked it
becomes checked. Clicking the button again turns the trajectory display off. The colour and style of the
missile/projectile trajectory can be changed using the controls provided.

If the MPC panel is opened and new waypoints are defined and saved for the current session, MiDLE is
ready to calculate the trajectory for the new scenario. Clicking on Trajectory >Enable is no longer
possible as the new trajectory data has not yet been calculated. When MiDLE is executed it will
automatically display the new trajectory after which Trajectory >Enable button will become re
sensitized.

6.2.4.2 Radar Display Control
The radar display control is used to toggle the following quantities in the view:

o Azimuth scan region
Enable
Colour

o Antenna boresight
Enable
Colour



Both of these menu buttons become checked when selected and the display will be updated with the
corresponding objects. Figure 43 shows the MiDLE view with the azimuth scan region and antenna
boresight displays enabled.

Figure 43: Azimuth Scan Region and Antenna Boresight Display

The image shown in Figure 43 corresponds to the default azimuth scan and antenna boresight values in
the RPC panel. The initial azimuth angle is 270° and the azimuth extent of scan is 90°. The antenna
boresight azimuth angle is 315° and the boresight elevation angle is 75°. These values agree with the
image shown in the above figure.

MiDLE will update the view when these values are changed in the Radar Parameters Control panel and
the APPLY button is pressed.

It is important to define these parameters accurately as currently MiDLE does not do extensive error
checking. For example, when a new set of waypoints is defined, the user must make sure that the
missile trajectory lies within the region scanned by the radar. It is also important to set the antenna
boresight closer to the middle of the scan region. The graphic presentation of data by MiDLE helps to
assure that these conditions are avoided.

6.2.4.3 Terrain Display Control
The terrain display control is used to manipulate the following quantities in the view:

o Elevation
Enable
Colours
Type (Filled or Lined)
Exaggeration (None, 2x, 5x, 10x)

o Coastline



Enable
o Landcover

Enable

MiDLE displays terrain elevation data when it is launched. By default IDL colour table #4 (Blue Green
Red Yellow) is used to contour elevation data to 30 different levels. The user can change the colour
table used and the colour mapping by clicking on the ‘Colours’ button. This opens the Contour Colours
Selection (CCS) panel shown in Figure 44.

Figure 44: Contour Colours Selection Panel

Colour indices 100 (green) to yellow (255) are mapped to 30 different elevation levels. The colour
spectrum can be increased to map the entire colour range (blue to yellow) by moving the Minimum
Colour Index slider all the way to the left. The Minimum Colour Index slider can however be moved only
to index 226 towards the right because there has to be a minimum of 30 contour colours.
Clicking on the ‘Colour table’ menu button offers the following colour selections:

0: Black White Linear 11: Blue Red
1: Blue White Linear 13: Rainbow
2: Green Red Blue White 16: Haze
3: Red Temperature 17: Blue Paste Red
4: Blue Green Red Yellow (default) 25: Mac Style
5: Standard Gamma II 29: Nature
6: Prism 33: Blue Red 2
7: Red Purple 34: Rainbow 2
8: Green White Linear 36: Volcano
9: Green White Exponential
10: Green Pink

The list above are standard IDL colour table numbers and names. The image shown in Figure 45 was
generated using colour table #16 (Haze) with indices 100 to 255. The order of the indices was also
reversed using the ‘Order’ menu.



Figure 45: Filled Terrain Elevation Contour Using Colour Table 16

The terrain elevation contour shown by default is a ‘filled’ type, however this can be changed to a ‘lined’
contour. This is shown in the next Figure 46. Displaying a lined elevation contour is useful in certain
applications, for example when the view needs to be de cluttered but still show terrain elevation
information.

Figure 46: Lined Terrain Elevation Contour

MiDLE displays colour coded terrain elevation data as shown in the previous figures. The terrain
elevation data can be exaggerated (multiplied) by factors of 2, 5 and 10 by selecting
Display >Terrain >Elevation >Exaggeration. This feature is for visually emphasizing terrain elevation and
is useful in certain applications. Figure 47 below shows an example of a 10x exaggerated view with the
coastline disabled.



Figure 47: View with Exaggerated Terrain Elevation

Normally MiDLE displays terrain elevation in the view. If the user selects
Display >Terrain >Landcover >Enable the terrain type data is displayed for the geographical region
covered. The terrain type graphics layer is located ‘below’ the elevation data layer therefore the terrain
elevation data should be deselected. Figure 48 is a plan view of the missile trajectory showing land
cover data.

If the user clicks anywhere within the view, the system message window displays the following
information:

o Landcover type,
o GeoBase landcover code,
o Colour code.

where the landcover type describes the terrain type (e.g. water, developed, forest, etc), the GeoBase
landcover code (0 to 233), and the actual red, green and blue primary colour values.

Note that Figure 48 shows the Halifax, Nova Scotia area with the purple colour (code 34) representing
built up or non vegetated regions.



Figure 48: Terrain Landcover Display

Figure 49 shows how both terrain landcover data and terrain elevation data may be visualized. First
enable both elevation and landcover displays, select the black white linear colour table #0 and select
lined contour. The view will change as shown below.

Figure 49: Terrain Landcover with Elevation Contour Lines

6.2.4.4 Ocean Display Control
The lowest graphics layer of the MiDLE GUI is the ‘ocean’ layer. For certain applications this layer can be
disabled by selecting Display >Ocean >Enable which toggles this layer on and off. When enabled the
‘ocean’ surface may be changed to a gridded surface as shown in Figure 50.

Built up regions



Figure 50: View with Gridded Ocean Surface

In Figure 50 the terrain elevation was set to a lined contour and the range circles and azimuth lines were
removed.

6.2.4.5 Symbology Display Control
The MiDLE top level ‘Display’ menu contains the ‘Symbols’ menu which can be used to control how
symbology in presented in the view. It consists of the following selections:

o Axis
Text
Colour

o Grid
Lines
Circles
Colour

o Cursor
Colour

The purpose of these controls is essentially to de clutter the display by removing the axis text, the grid
lines and circles or changing their colours.

The cursor cannot be removed and only its colour may be changed. Clicking anywhere within the view
region displays the elevation of the point in meters, its range from the radar in kilometers, its bearing
from the radar in degrees, and its longitude and latitude position as shown in Figure 51.



Figure 51: The Cursor Display

Clicking anywhere within the view then holding down the <Ctrl> key and clicking again at a different
location displays the distance separating the two points in meters, as illustrated in Figure 52.

Figure 52: Displaying Distance Between Two Points

6.2.4.6 Background Display Control
The background display controls enables changing the view background colour from the default gray to
either black, white or blue to create a different visual effect.

6.2.4.7 Visibility Display Control
The visibility display control setting is ‘Unlimited’ by default. To create different visual effects, the
visibility can be decreased to 75, 50, 25 or 0 percent. In Figure 52 a white background was selected with
25% visibility. Range circles and azimuth lines were removed for clarity. The missile path from its launch
position to the target is clearly visible.

1st point

2nd point



Figure 53: Background Colour and Visibility Use Example

6.2.4.8 Platform Display Control
The default radar platform used by MiDLE is the Halifax class Canadian Patrol Frigate (CPF) equipped
with the Sea Giraffe and AN/SPS 49 radars. Using the GUI zoom controls (right mouse button click in the
upper view area or ‘+’ on the numerical keypad) the ship is displayed as shown in Figures 54 and 55.
The radar azimuth scan region is visible.

MiDLE is able to display models of other platforms but these have been disabled. The radar platform
used is always the Canadian Patrol Frigate.

Figure 54: The CPF Radar Platform



Figure 55: Radar Platform Showing Azimuth Scan Region

6.2.4.9 Detection Display Control
MiDLE calculates the probability of detecting a threat in the littoral environment and displays this data
in the view after execution is complete. The visual display of the probability of detection is only to give
the user qualitative information. More precise, quantitative data can be generated in the form of plots
as shown later.

In the example shown in Figure 56 the dwell probability of detection is superimposed on the missile
trajectory as detection lines. These lines are proportional in height to the probability of detection at a
given point along the missile trajectory. Lines which exceed the detection threshold are coloured red.
(The detection threshold is specified in the CPC panel). Selecting Display >Detection >Enable toggles the
detection lines on and off. This control is only enabled after MiDLE runs and the probability of detection
values have been calculated for a given scenario.

Figure 56: Missile Trajectory with Superimposed Detection Lines



6.2.4.10 Overlay Display Control
MiDLE can overlay the following quantities on the view:

o Surface clutter power,
o Weather clutter power,
o Surface reflectivity,
o Reflectivity factor,
o Wave height,
o Duct height.

The graphics surfaces of these quantities can be overlaid on the MiDLE view by selecting Display
>Overlay, whereby the selected quantity’s button becomes checked. Selecting the same quantity again
removes it from the view and the button is un checked. Only a single quantity can be viewed at any
given time. Selecting another quantity removes the existing one and displays the one specified.

6.2.4.10.1 Surface Clutter Power Overlay
Figure 57 shows the surface clutter power overlay and its corresponding colourbar. The program
requests the burst number from the user before the overlay is generated. The surface clutter power
overlay is not completely opaque and gives a hint of the underlying terrain features. If the underlying
terrain elevation is not required it can be disabled by selecting
Display >Terrain >Elevation >Enable which toggles it on and off.

Figure 57: Surface Clutter Power Overlay



6.2.4.10.2 Weather Clutter Power Overlay
MiDLE only calculates the weather clutter power if it is explicitly specified in the Program Execution
Control panel. When the user requests the weather clutter power overlay the program informs the user
of this and can optionally generate the overlay using existing data (e.g. from the
WeatherClutter_nC_default.dat file). The burst number for which the overlay is to be generated is
obtained from the user.

Figure 58 shows an example weather clutter power overlay and its corresponding colourbar. In this
figure the terrain elevation data has been deliberately disabled to clarify the image.

Figure 58: Weather Clutter Power Overlay



6.2.4.10.3 Surface Reflectivity Overlay
For the surface reflectivity overlay the program first obtains the burst number from the user as for the
surface and weather clutter power overlays. Figure 59 shows an example surface reflectivity overlay for
burst #0 with its corresponding colourbar. In this image the ground elevation details have been disabled
to clarify the view. Note that in this case the region covered extends past the radar scan region.

Figure 59: Surface Reflectivity Overlay



6.2.4.10.4 Reflectivity Factor Overlay
Clicking on Display >Overlay >Reflectivity factor opens a file dialog box showing the contents of the
DATA directory. The following metafiles can be selected:

o *CAPPI1,
o *CAPPI4,
o *ECHOTOP,
o *PRECIP

Figure 60 shows the overlay generated for the *PRECIP file and its corresponding colourbar. The ground
elevation details have been disabled to clarify the view.

Figure 60: Reflectivity Factor Overlay



6.2.4.10.5 Wave Height Overlay
The wave height overlay is shown in Figure 61. In this figure the view was zoomed in to show more
detail of the area of interest. The terrain elevation, coastline and ocean features have been disabled for
clarity.

Figure 61: Wave Height Overlay



6.2.4.10.6 Duct Height Overlay
The duct height overlay is shown in Figure 62. As for the wave height overlay, the view was zoomed in
to show more detail of the area of interest. The terrain elevation, coastline and ocean features have
been disabled for clarity.

Figure 62: Duct Height Overlay

6.2.5 The Plot Menu
The top level ‘Plot’ menu is for the generation of plots (graphs) of various quantities calculated by
MiDLE. These include:

o Missile properties,
o Missile propagation factor,
o Power received from missile,
o Surface propagation factor,
o Surface clutter,
o Probability of detection,
o Wave direction,
o Wind velocity,
o Swell direction.



MiDLE always uses as input the results of the latest calculations when generating plots. These results
are stored in the MissilePath_<mod>_PlotQty.dat file, where ‘mod’ is a filename modifier. This file
contains all necessary quantities to generate the plots. The following sections feature example plots
generated using data from theMissilePath_default_PlotQty.dat file.

6.2.5.1 Missile Properties Plot
The example missile properties plot is shown in Figure 63. This plot is actually a compound plot
containing five distinct missile properties:

o Range (kilometers),
o Azimuth (degrees),
o Height (meters),
o Radial velocity (ms ¹),
o RCS (dB).

The missile properties plot first appears minimized when opened but can be expanded to show
individual plots. The ‘Control’ menu offers various choices to view the plots including changing the
background colour. Plots of previous results can be plotted using the ‘Load’ button. The plot image can
be saved as an encapsulated PostScript file using the ‘Save’ button for importing into documents. The
‘Save’ button opens a file dialog box where the file path and name can be specified. By default the
image is saved to the OUTPUT directory as a type *.eps file.

Figure 63 shows an example missile properties plot. The missile properties plots are always generated
as property vs. time plots.

Figure 63: Missile Properties Plot



6.2.5.2 Missile Propagation Factor Plot
The plot of the missile propagation factor (PF) is shown in Figure 64. For the default case the radar uses
four bursts. The propagation factor calculated by MiDLE for each burst are shown. Up to a maximum of
20 bursts can be plotted.

Figure 64: Missile Propagation Factor vs. Range Plot

The missile propagation factor ‘Control’ menu contains the following buttons to control how the data is
plotted:

o Exit,
o Clear,
o Reset,
o Burst,
o Abscissa,
o Background,
o Axes,
o Load,
o Save.

The ‘Exit’ button simply closes the plot window and the ‘Clear’ button clears it. The ‘Reset’ button re
loads the initial plots when the window was first opened. The ‘Burst’ button allows individual bursts to
be plotted at a time. The ‘Abscissa’ button enables selection between missile PF vs. range and missile
PF vs. time plots. The ‘Background’ button offers a choice of three different background colours. The
‘Axes’ button is used to control the range of the x and y axes.

Figure 65 shows an example missile PF plot vs. time plot. In this plot the x and y axes were adjusted to
view the data in the 0 to 60 second range.



Figure 65: Missile Propagation Factor vs. Time Plot

Missile PF values from previous calculation results can be plotted using the ‘Load’ button. This opens a
file dialog box where the file path and name can be specified. The ‘Reset’ button must be pressed after
new data is loaded.

The plot can be saved to an encapsulated PostScript file using the ‘Save’ button.

6.2.5.3 Power Received From Missile Plot
The plot of the power received from missile (PRM) is shown in Figure 66. For the default case the radar
uses four bursts. The received missile power calculated by MiDLE for each burst are shown. Up to a
maximum of 20 bursts can be plotted.

Figure 66: Received Missile Power vs. Range Plot

The power received from missile ‘Control’ menu contains the following buttons to control how the data
is plotted:

o Exit,
o Clear,
o Reset,
o Burst,
o Abscissa,



o Background,
o Axes,
o Load,
o Save.

The ‘Exit’ button simply closes the plot window and the ‘Clear’ button clears it. The ‘Reset’ button re
loads the initial plots when the window was first opened. The ‘Burst’ button allows individual bursts to
be plotted at a time. The ‘Abscissa’ button enables selection between received missile power vs. range
and received missile power vs. time plots. The ‘Background’ button offers a choice of three background
colours. The ‘Axes’ button is used to control the range of the x and y axes.

Figure 67 shows an example received missile power plot vs. time plot. In this plot the x and y axes were
adjusted to view the data in the 60 to 110 second range.

Received missile power values from previous calculation results can be plotted using the ‘Load’ button.
This opens a file dialog box where the path and filename can be specified. The ‘Reset’ button must be
pressed after new data is loaded.

The plot can be saved to an encapsulated PostScript file using the ‘Save’ button.

Figure 67: Received Missile Power vs. Time Plot

6.2.5.4 Surface Propagation Factor Plot
The plot of the surface propagation factor (SF4) vs. range is shown in Figure 68. For the default case the
radar uses four bursts and 295 beams. The SF4 calculated by MiDLE for each burst are shown for beam
#0. Up to a maximum of 20 bursts can be plotted.



Figure 68: Surface Propagation Factor vs. Range Plot

The surface propagation factor ‘Control’ menu contains the following buttons to control how the data is
plotted:

o Exit,
o Clear,
o Reset,
o Burst,
o Beam,
o Abscissa,
o Background,
o Axes,
o Load,
o Save.

The ‘Exit’ button simply closes the plot window and the ‘Clear’ button clears it. The ‘Reset’ button re
loads the initial plots when the window was first opened. The ‘Burst’ button allows individual bursts to
be plotted at a time. The ‘Abscissa’ button enables selection between surface propagation factor vs.
range and surface propagation factor vs. time plots. The ‘Background’ button offers a choice of three
background colours. The ‘Axes’ button is used to control the range of the x and y axes.

For the SF4 vs. range case the ‘Beam’ button is sensitized and the user can generate plots for individual
beams. A total of 296 beams can be plotted for the default scenario. For the surface PF vs. time case
however this button is desensitized as the PF values are plotted with respect to the missile.

Figure 69 below shows the SF4 vs. time plot.



Figure 69: Surface Propagation Factor vs. Time Plot

Surface propagation factor values from previous calculation results can be plotted using the ‘Load’
button. This opens a file dialog box where the file path and name can be specified. The ‘Reset’ button
must be pressed after new data is loaded.

The plot can be saved to an encapsulated PostScript file using the ‘Save’ button.

6.2.5.5 Surface Clutter Power Plot
The plot of the surface clutter power (SCP) vs. range is shown in Figure 70. For the default case the
radar uses four bursts and 61 missile illuminating beams within the azimuth scan. The SCP calculated by
MiDLE for each burst is shown for beam #0. Up to a maximum of 20 bursts can be plotted. The plot also
displays the saturation and noise power levels as reference.

Figure 70: Surface Clutter Power vs. Range Plot

The surface clutter power ‘Control’ menu contains the following buttons to control how the data is
plotted:

o Exit,
o Clear,
o Reset,
o Burst,



o Beam,
o Missile path,
o Abscissa,
o Background,
o Axes,
o Load,
o Save.

The ‘Exit’ button simply closes the plot window and the ‘Clear’ button clears it except for the saturation
and noise power levels. The ‘Reset’ button re loads the initial plots when the window was first opened.
The ‘Burst’ button allows individual bursts to be plotted at a time. The ‘Abscissa’ button enables
selection between surface clutter power vs. range and surface clutter power vs. time plots. If the
‘Abscissa’ button is changed to ‘Time’, the ‘Missile path’ button becomes checked as the SCP vs. time is
plotted with respect to the missile along all beams.

The ‘Background’ button offers a choice of three different background colours. The ‘Axes’ button is
used to control the range of the x and y axes.

If the ‘Beam’ button is selected, the display reverts back to the SCP vs. range plot. Selecting ‘Missile
path’ allows for the generation of either SCP vs. range or SCP vs. time plots along the missile path.
Figures 71 and 72 show example plots of each of these quantities.

Figure 71: Surface Clutter Power Along Missile Path vs. Range Plot

Figure 72: Surface Clutter Power Along Missile Path vs. Time Plot



Surface clutter power values from previous calculation results can be plotted using the ‘Load’ button.
This opens a file dialog box where the file path and name can be specified. The ‘Reset’ button must be
pressed after new data is loaded.

The plot can be saved to an encapsulated PostScript file using the ‘Save’ button.

6.2.5.6 Probability of Detection Plot
The plot of probability of detection (PD) vs. range is shown in Figure 73. The plot shows the PD values
for each of the four colour coded bursts plus the dwell probability of detection (shown in black).

Figure 73: Probability of Detection vs. Range Plot

The probability of detection ‘Control’ menu contains the following buttons to control how the data is
plotted:

o Exit,
o Clear,
o Reset,
o Burst,
o Abscissa,
o Background,
o Axes,
o Load,
o Save.

The ‘Exit’ button simply closes the plot window and the ‘Clear’ button clears it. The ‘Reset’ button re
loads the initial plots when the window was first opened. The ‘Burst’ button allows individual bursts to
be plotted at a time as well as the dwell. The ‘Abscissa’ button enables selection between PD vs. range
and PD vs. time plots. The ‘Background’ button offers a choice of three different background colours.
The ‘Axes’ button is used to control the range of the x and y axes.

Probability of detection values from previous calculation results can be plotted using the ‘Load’ button.
This opens a file dialog box where the file path and name can be specified. The ‘Reset’ button must be
pressed after new data is loaded.



The plot can be saved to an encapsulated PostScript file using the ‘Save’ button. The dwell probability of
detection vs. time plot is shown in Figure 74. When this figure is compared to Figure 56 (missile
trajectory with superimposed detection lines) the correspondence between the quantitative and
qualitative data can be observed.

Figure 74: Dwell Probability of Detection vs. Time Plot

6.2.5.7 Wave Direction Plot
The plot of the wave direction is shown in Figure 75. The plot shows wave direction for both inland and
ocean water regions. The ‘Control’ menu enables the image to be saved to an encapsulated PostScript
file.

Figure 75: Wave Direction Plot



6.2.5.8 Wind Velocity Plot
The plot of the wind velocity is shown in Figure 76.

Figure 76: Wind Velocity Plot

6.2.5.9 Swell Direction Plot
The plot of the swell direction is shown in Figure 77.

Figure 77: Swell Direction Plot



6.3 Program Execution Flow
When MiDLE is executed using Program >Start, its execution flow is determined by the user defined
settings of the Program Execution Control panel. The flow diagram shown on the next few pages charts
the sequence of program execution.

MiDLE first executes the define.pro procedure where all of the default parameters are set. These
parameters are stored into structures (e.g. rad, env con, etc.) that are accessed by the program on a
continuous basis. These structures are used by the various algorithms that perform calculations. MiDLE
also executes the common_defs.pro procedure where all of the global variables are defined. These
global variables are used mainly to control the GUI.

The main program is MiDLE.pro. If MiDLE was set to diagnostic mode it calls the DiagnosticDisplay
procedure. This opens a window that blocks program execution until the user closes it. The window
displays the contents of the various structures used. In diagnostic mode MiDLE updates the
diagnostic.log file which can be inspected later.

6.3.1 Missile / Projectile Trajectory Calculation
Next the target type is determined. If the target type is ‘Missile’ and ‘restore’ was set for the trajectory
then the program looks for theMissilePath_<mod>.dat file where ‘mod’ is the file modifier. If this file is
not found then the program will restore the trajectory data from the MissilePath_default.dat file. The
default trajectory file should always exist in the OUTPUT directory unless it was accidentally deleted. In
this case the program will issue a warning and stop processing. Note that MiDLE still remains active and
the user can access all of the program controls. If ‘execute’ was set for the missile trajectory, the
program calls the CircleSmooth procedure to calculate the trajectory data. The trajectory data is saved
in theMissilePath_<mod>.dat file.

The ‘Projectile’ target type case is treated similarly. If ‘execute’ was specified the program calls the
Ballistic procedure to calculate the projectile trajectory. The output variables generated by both
CircleSmooth and Ballistic are:

o rpath,
o phpath,
o thpath,
o vpath,
o max_tta.

At this point MiDLE displays the missile or projectile trajectory which appears in the view as a white
dotted line.

If the ‘Generate KML’ switch was set in the Expert Parameters Control panel, the program will convert
the trajectory data into a *.kml file for importing into Google Earth. This file is located in the OUTPUT
directory.



Figure 78a: MiDLE Program Flow Chart

6.3.2 Scanning Characteristics Determination
MiDLE calls the DefineScan procedure next to calculate the scanning characteristics. The input variable
is:

o phpath.

Output variables generated by DefineScan are:

o phba,
o nbeam,
o rcmin,
o rcint,
o kph,
o th3s,
o gfac,



o ph3s,
o APM_antenna_pattern,
o rc,
o nUniqMisbeams,
o UniqMisbeams,
o nq,
o phq,
o nqint,
o MaxBinRange,
o nUniqMisq,
o UniqMisq,
o phASS,
o SLmaxPh,
o kth,
o thASS,
o SLmaxTh,
o ph_antenna_pattern,
o th_antenna_pattern.

6.3.3 Refractivity Profile Calculation
If no HPAC data is available (e.g. HPAC data is zero in the EPC panel), MiDLE uses a single refractivity
profile throughout. If HPAC data is available and ‘restore’ was set in the Program Execution Control
panel then the program searches for theM_<mod>.dat file where ‘mod’ is the file modifier. If this file is
not found then the program will restore refractivity data from the M_default.dat file. The default
refractivity file should always exist in the OUTPUT directory unless it was accidentally deleted. In this
case the program issues a warning and stops processing. Note that MiDLE remains active and the user
can access all of the program controls. If ‘execute’ was set for refractivity profile calculations, the
program calls the readHPAC_SM procedure to calculate the data. The output data is saved in the
M_<mod>.dat file.

The input variables to readHPAC_SM are:

o MaxBinRange,
o phq,
o rcint,
o phba,
o th3s,
o hh3s.

Output variables generated by readHPAC_SM are:

o GEMnx,
o GEMny,
o WindData,
o Mdata.



Figure 78b: MiDLE Program Flow Chart (cont’d)

6.3.4 Terrain Properties Determination
The terrain properties are determined next. If ‘restore’ was set for the terrain in the Program Execution
Control panel then the program looks for the Terrain_<mod>.dat file where ‘mod’ is the file modifier. If
this file is not found then the program will restore the terrain data from the Terrain_default.dat file. The
default terrain data file should always exist in the OUTPUT directory unless it was accidentally deleted.
In this case the program will issue a warning and stop processing. Note that MiDLE still remains active
and the user can access all of the program controls. If ‘execute’ was set for the terrain properties, the
program calls the DefineTerrain procedure to calculate the data. The output data is saved in the
Terrain_<mod>.dat file.

The input variables to DefineTerrain are:



o nq,
o phq,
o MaxBinRange,
o WindData,
o rcint.

Output variables generated by DefineTerrain are:

o terr,
o hsig.

6.3.4.1 Terrain Elevation Data Processing
The DefineTerrain procedure inputs terrain elevation data generated by MiDLE. This data is read from
files of type *.el1 or *.el2 contained in the ELDATA subdirectory. MiDLE can process raw DTED or CDED
terrain elevation files placed in the ELDATA folder into a format that can be used directly and more
efficiently.

The file conversion is performed by the process_dem and process_dtd procedures. The *.el1 and *.el2
files contain elevation arrays that are joined together by the read_all_CDED function as needed to cover
the specified range. These procedures automatically compensate for the number of longitudes covered
by each raw elevation data file. For example, CDED cells above 68° latitude cover 2° of longitude and
above 80° latitude cover 4° of longitude. The conversion procedures therefore generate 2 output files
for each input file above 68° latitude and 4 output files above 80° latitude.

Terrain elevation files do not always exist in certain situations. This can happen if a new location is
specified for the radar platform and the user has not loaded elevation data files for the region covered.
It can also happen if the radar is positioned as shown in Figure 79.

Figure 79: Terrain Elevation Data Processing

The elevation data cell in the bottom right corner of Figure 79 is entirely over water and therefore there
is no corresponding elevation data file. MiDLE will detect the missing cell and issue the following
message:

Terrain Ocean

Missing elevation
cellRadar

platform



Terrain elevation data file <filename> was not found. 
      Zero elevation values will be used assuming that 
      the cell covers an area that is entirely over water. 

      Proceed?

The user can optionally terminate execution at this point, load the required elevation data files and run
MiDLE again. The user can also choose to proceed whereby an elevation value of zero is used
throughout for the cell in question.

6.3.4.2 Landcover Type Data Processing
The DefineTerrain procedure inputs landcover type data generated by MiDLE. This data is read from
files of type *.lc1 or *.lc2 contained in the LCDATA subdirectory. MiDLE can process raw landcover files
(shapefiles) placed in the LCDATA folder into a format that can be used directly and more efficiently.

The file conversion is performed by the process_shapefile3 procedure. The *lc1 and *.lc2 files contain
terrain type arrays that are joined together by the program as needed to cover the specified range.

As with terrain elevation data files, in certain situations landcover type files may not exist. This can
occur if a new location is specified for the radar platform and the user has not loaded terrain type data
files for the region covered. The read_all_LANDC function will detect the missing terrain type data cell
and issue the following message:

Land cover data file <filename> was not found. 
      Index 20 will be used assuming that 
      the cell covers an area that is entirely over water. 

      Proceed? 

The user can optionally terminate execution at this point, load the required landcover data files and run
MiDLE again. The user can also choose to proceed whereby a landcover value of 20 (water) is used
throughout for the cell in question.

6.3.5 Clutter RangeWeights Calculation
The clutter range weight data is restored or calculated next depending on the setting of the
corresponding control in the Program Execution Control panel. If ‘restore’ was set for the clutter range
weights then the program looks for the ClutterRangeWeights_<mod>.dat file where ‘mod’ is the file
modifier. If this file is not found then the program will restore the terrain data from the
ClutterRangeWeights_default.dat file. The default data file should always exist in the OUTPUT directory
unless it was accidentally deleted. In this case the program will issue a warning and stop processing.
Note that MiDLE still remains active and the user can access all program controls. If ‘execute’ was set
for the terrain properties, the program calls the ClutterRangeWeights_SM procedure to calculate the
data. The output data is saved in the ClutterRangeWeights_<mod>.dat file.



The input variable to ClutterRangeWeights is:

o rc,

Output variables generated by ClutterRangeWeights are:
o rcRangeFold,
o W2q.

Note that all *_SM procedures use parallel processing to reduce program execution time and use shared
memory (SM) for inter process communications.

6.3.6 Propagation Factor Calculation
The 2 way surface propagation data is calculated (or restored) next depending on the control settings in
the Program Execution Control panel.

If ‘restore’ was set for the propagation factor, then the program looks for the
ExtractedSurfaceF4_<mod>.dat file where ‘mod’ is the file modifier. If this file is not found then the
program will restore the terrain data from the ExtractedSurfaceF4_default.dat file. The default data file
should always exist in the OUTPUT directory unless it was accidentally deleted. In this case the program
will issue a warning and stop processing. MiDLE still continues to run and the user can access program
controls. If ‘execute’ was set for the terrain properties, the program calls the propagation_SM
procedure to calculate the data. The output data is saved in the ExtractedSurfaceF4_<mod>.dat file.

The propagation_SM procedure spawns child (slave) processes depending on the number of CPUs
available on the platform. MiDLE will always use the maximum number of cores available unless this
number is changed in the Control Parameters Control panel. The slave processes call the APM DLL to
calculate the surface and missile propagation factors and grazing angles. The master process
communicates with the slave processes using shared memory. The master will wait (block processing)
until all slave processes have successfully completed.

The input variables to propagation_SM are:

o th3s,
o ph3s,
o nq,
o APM_antenna_pattern,
o Mdata,
o MaxBinRange,
o rcint,
o max_tta.

Output variables generated by propagation_SM are:

o F4th,
o psigr,
o F4th_SO,
o logpsigr_SO.



The propagation calculation results are saved as files in the APM/OUTPUT directory.

6.3.7 Reflectivity Factor Field Calculation
If the precipitation field is ‘3D’ in the EPC panel, and if the ‘Precipitation’ control is enabled in the
Program Execution Control panel, and if weather clutter power calculations are commanded, then
MiDLE will call the DefineZ procedure to calculate the reflectivity factor field.

The input variables to DefineZ are:

o MaxBinRange,
o th3s.

Output variables generated by DefineZ are:

o dbzX,
o dbzY,
o dbzH,
o dbz,
o lonr,
o latr,
o Hmax.

6.3.8 Missile Trajectory Limiting
If the radar scan type is ‘EE’ (electronic in azimuth and electronic in elevation) in the RPC panel then
MiDLE will call the MissileTrajectoryE procedure to calculate the position of the target for each
transmitted pulse. If the scan type is not ‘EE’ then theMissileTrajectoryM procedure is called.

The input variables toMissileTrajectoryE andMissileTrajectoryM are:

o rpath,
o phpath,
o vpath,
o nbeam,
o phq.

Output variables generated byMissileTrajectoryE andMissileTrajectoryM are:

o tpath,
o rm,
o tpath,
o thm,
o phm,
o vrm,
o timem,
o nscan,



o misbeams,
o nIllBeams,
o misburst,
o misq,
o misGroupBeams,
o HeadingAz,
o HeadingTh,
o misScans,
o BurstStartTime.

Figure 78c: MiDLE Program Flow Chart (cont’d)



6.3.9 Intermediate Data Generation
If the ‘iData’ flag is set in the Expert Parameters Control panel to generate intermediate data then the
program next calls the Trajectory_files procedure.

The input variables to Trajectory_files are:

o rpath,
o phpath,
o thpath,
o vpath,
o tpath.

No output variables are generated by Trajectory_files. The intermediate data files are placed in the
OUTPUT directory.

6.3.10 Radar Cross Section Calculation
The program calls the MissileRCS procedure next to create an array of radar cross sections
corresponding to each missile position.

The input variables toMissileRCS are:

o rm,
o phm,
o thm,
o HeadingAz,
o HeadingTh.

The output variable generated byMissileRCS is:

o rcs.



Figure 78d: MiDLE Program Flow Chart (cont’d)

6.3.11 Missile I/Q Data Calculation
The MissileIQ_SM procedure is called next to determine the I and Q signals corresponding to the target.
This procedure is also parallelized to take advantage of multiple CPUs available on the platform and uses
shared memory for inter process communications.

The input variables toMissileIQ_SM are:

o kph,
o ph3s,
o misbeams,
o misScans,



o misburst,
o nUniqMisq,
o UniqMisq,
o Misq,
o misGroupBeams,
o nscan,
o nq,
o nIllBeams,
o rm,
o thm,
o gfac,
o rc,
o vrm,
o phba,
o phm,
o rcs,
o Rcint.

Output variables generated byMissileIQ_SM are:

o bigrc,
o bigI,
o bigQ,
o bigMisbeams,
o bigMisScans,
o bigMisBurst,
o bigMisGroupBeams,
o bigrm,
o mF4th.

6.3.12 Missile Power Limiting
The LimitMissile procedure limits the missile data to the beams and range bins that correspond to the
maximum target signal strength for each burst. The calculated missile powers are then reduced to
arrays corresponding only to these limited ranges.

The input variables to LimitMissile are:

o nIllBeams,
o bigrc,
o bigI,
o bigQ,
o bigMisbeams,
o bigrm,
o bigMisGroupBeams.

Output variables generated by LimitMissile are:



o trimrc,
o trimI,
o trimQ,
o trimMisbeams,
o trimMisGroupBeams,
o rIllindex.

6.3.13 Weather Clutter Power Calculation
The weather clutter power calculations are performed next if this control is enabled in the Program
Execution Control panel.

If the precipitation field is set to ‘Constant’ in the EPC panel then the ‘0D’ case is in effect. If ‘restore’
was set for the weather clutter power, then the program looks for the wcpow_0D_<mod>.dat file
where ‘mod’ is the file modifier. If this file is not found then the program will restore the terrain data
from the wcpow_0D_default.dat file. The default data file should always exist in the OUTPUT directory
unless it was accidentally deleted. In this case the program will issue a warning and stop processing.
MiDLE still continues to run and the user can access all program controls. If ‘execute’ was set for the
terrain properties, the program calls the wcpow_0D_SM procedure to calculate the data. The output
data is saved in the wcpow_0D_<mod>.dat file.

If the precipitation field is set to ‘Profile’ in the EPC panel then the ‘1D’ case is in effect. If ‘restore’ was
set for the weather clutter power, then the program looks for the wcpow_1D_<mod>.dat file where
‘mod’ is the file modifier. If this file is not found then the program will restore the terrain data from the
wcpow_1D_default.dat file. The default data file should always exist in the OUTPUT directory unless it
was accidentally deleted. In this case the program will issue a warning and stop processing. MiDLE still
continues to run and the user can access all program controls. If ‘execute’ was set for the terrain
properties, the program calls the wcpow_1D_SM procedure to calculate the data. The output data is
saved in the wcpow_1D_<mod>.dat file.

The ‘3D’ case is treated similarly as for the ‘0D’ and ‘1D’ cases described above. MiDLE either restores
the wcpow_3D_default.dat or executes the wcpow_3D_SM procedure.

The input variables to wcpow_3D_SM are:

o th3s,
o th_antenna_pattern,
o rcint,
o nq,
o phba,
o nbeam,
o rc,
o ph3s,
o kph,
o phq,
o W2q,



o gfac,
o phASS,
o SLmaxPh,
o thASS,
o SLmaxTh,
o rcRangeFold.

Output variables generated by wcpow_3D_SM are:

o PWc,
o La,
o Laq,
o Zeint,
o WCDopplerSpec.

6.3.14 Weather Clutter Power Limiting
The program next calls the LimitWeatherClutter procedure if ‘Precipitation’ is set in the Program
Execution Control panel. This limits the weather clutter power data to the beams and range bins that
correspond to the maximum target signal strength for each burst.

The input variables to LimitWeatherClutter are:

o trimrc,
o trimMisbeams,
o PWc.

The output variable generated by LimitWeatherClutter is:

o trimPWc.



Figure 78e: MiDLE Program Flow Chart (cont’d)

6.3.15 Surface Clutter Power Calculation
MiDLE next calls the scpow_SM procedure to calculate the surface clutter power.

The input variables to scpow_SM are:

o kph,
o gfac,
o ph3s,
o nq,
o nqint,
o nbeam,
o rcint,
o phq,
o phba,
o rc,



o UniqMisbeams,
o Trimrc,
o trimMisbeams,
o rcRangeFold,
o phASS,
o SLmaxPh,
o La,
o Laq.

Output variables generated by scpow_SM are:

o PrSC,
o trimPrSC,
o trimstat,
o SCDopplerSpec,
o trimF4th,
o ref.

6.3.16 Noise Power Calculation
The noise procedure is called next to calculate the receiver system mean noise power. The output
variable is ‘Pn’.

6.3.17 Jammer Power Calculation
If the ‘Jammer’ control is enabled in the Program Execution Control panel and ‘Jammer power’ is set to
‘execute’, MiDLE calls the jammer procedure. Else if ‘restore’ is set then the Jammer_<mod>.dat file is
restored from the OUTPUT directory where ‘mod’ is the filename modifier. If this file does not exist
then MiDLE will restore the Jammer_default.dat file. The default data file should always exist in the
OUTPUT directory unless it was accidentally deleted. In this case the program will issue a warning and
stop processing. MiDLE still continues to run and the user can access all of the program controls.

The input variables to jammer are:

o gfac,
o rc,
o trimrc,
o trimMisbeams,
o nbeam,
o phba,
o ph3s,
o kph,
o phq,
o MaxBinRange,
o Max_tta,
o Rcint,
o Mdata.



Output variables generated by jammer are:

o Pjam,
o trimPjam.

Figure 78f: MiDLE Program Flow Chart (cont’d)

6.3.18 Full Scan I/Q Data Calculation
If the radar scan type specified in the RPC panel is ‘EE’ and the ‘Full scan IQ’ switch is set in the Expert
Parameters Control panel, MiDLE will execute the FullScanIQ_SM procedure. Note that these
calculations are very time consuming even with the use of parallel processing techniques.

The input variables to FullScanIQ_SM are:

o kph,
o gfac,
o ph3s,



o nq,
o nqint,
o nbeam,
o rcint,
o phq,
o phba,
o phASS,
o SLmaxPh,
o rc,
o Pn,
o PrSC,
o Pjam,
o bigI,
o bigQ,
o bigMisbeams,
o bigrc,
o bigMisScans,
o bigMisBurst,
o nscan,
o BurstStartTime,
o La,
o Laq.

The output results from FullScanIQ_SM are saved in files.

6.3.19 Detection Thresholds and Probability of Detection Calculation
At this point calculations are nearly complete and MiDLE calls the ThreshProb_SM procedure to
calculate the detection thresholds and probabilities for each relevant range bin. This procedure is called
if ‘execute’ was specified in the Program Execution Control panel, else the file ThreshProb_<mod>.dat is
restored. If this file does not exist the MiDLE will restore the ThreshProb_default.dat file from the
OUTPUT directory. Again, if the default file was accidentally deleted case the program will issue a
warning and stop processing. MiDLE still continues to run and the user can access all program controls.

The input variables to ThreshProb_SM are:

o np,
o ph3s,
o phba,
o trimPrSC,
o trimstat,
o Pn,
o trimI,
o trimQ,
o trimMisbeams,
o SCDopplerSpec,
o trimPWc,



o WCDopplerSpec,
o trimPjam.

Output variables generated by ThreshProb_SM are:

o threshold,
o Pd_intlim,
o SatFlag,
o MDP,
o Fdindex.

6.3.20 Dwell Probability of Detection and Data Limiting
As the final step MiDLE calls the dwellPd procedure to calculate the probability of detection for the
dwell.

The input variables to dwellPd are:

o np,
o ranges_intlim,
o Pd_intlim.

Output variables generated by dwellPd are:

o Pdd_intlim,
o Pddu_intlim.

The output probability of detection data is limited for each missile illumination to the range bin of the
output response function that achieves the highest probability of detection.

Results of the detection thresholds and probability of detection calculations are saved in a structure.
Calculation results that are needed by the various plot generation routines are saved in the
MissilePath_<mod>_PlotQty.dat file where ‘mod’ is the filename modifier for the current scenario. The
overlay and plot generation functions discussed in sections 6.2.4.10 and 6.2.5 use the data contained in
this file.

6.4 Building the APM DLL and Executable Modules

6.4.1 Background
MiDLE uses the Advanced Propagation Model to perform propagation calculations. The APM
dynamically linked modules and executable modules are contained in the APM subdirectory. MiDLE
calls these programs based on the ‘APM Calling Method’ selected in the Control Parameters Control
panel. Currently two APM versions (APM 2.3.03 and APM 2.3.05) are available.



APM version 2.3.05 FORTRAN source file names are listed in Appendix B. The source files are contained
on the MiDLE distribution CD. In order to compile these files, Microsoft Visual Studio 2010 Professional
and Intel Visual Fortran Composer XE 2011must first be installed on a computer platform and licensed.

6.4.2 Visual Fortran Project Setup
First create a folder on your computer where the Visual Studio project and the APM source files will
reside. For example, create the directory C:\APM_TST_2305 and copy all FORTRAN source files (both
*.f90 and *.F90 files) to it.

Open MS Visual Studio and create a new project. The project type depends on whether a library or
console application is being created. Click on File >New >Project in the MS Visual Studio menu and
select the appropriate project type. A console application will build an executable image whereas a
library project will create a DLL module. Select a project name and specify the location as shown in the
following Figure 80. The solution name is entered automatically and defaults to the project name. The
project and solution names can be specified at the user’s discretion. In this example a DLL is created
and the project name APM_TST_2305 is used. Click on the OK button. MS Visual Studio creates new
folders in C:\APM_TST_2305 and inserts the corresponding *.sln and *.vproj files.

Figure 80: Visual Studio Project Setup Window

The right hand side Solution Explorer window now shows the following configuration:

o Solution ‘APM_TST_2305’ (1 project)
o APM_TST_2305



Header Files
Resource Files
Source Files

The above header files, resource files and source files folders are initially all empty. In this example only
source files are added. Right click on ‘Source Files’ and select Add >Existing Item. This opens up the
window shown in Figure 81. Navigate to the top level directory and select all FORTRAN source files.
Click the Add button.

Figure 81: Adding APM Source Files in Visual Studio Project

The Visual Studio Solution Explorer window now shows the APM FORTRAN source files that will be
compiled into the DLL. (The preprocessor is automatically invoked for files with types *.F90). At this
point a source file can be opened in the editor window by double clicking on it.

In this example a ‘release’ version (as opposed to the ‘debug’ version) of the APM DLL is being built on a
platform running a 64 bit operating system (Windows 7). The DLL generated will also be for a 64 bit
system. Make the necessary changes by right clicking on the project in Solution Explorer and select
‘Properties’. The solution Property Pages window is opened as shown in Figure 82.



Figure 82: Visual Studio Property Pages Window

Click on the ‘Configuration Manager’ which opens the configuration manager window. Change ‘Active
solution configuration’ to ‘Release’ and ‘Active solution platform’ to ‘x64’. If the ‘x64’ option is not
available, select <New> and specify ‘Copy settings from Win32’. The final configuration is shown in
Figure 83.

Figure 83: Visual Studio Configuration Manager Window

Click on the ‘Close’ button in the Configuration Manager. The Property Pages shown in Figure 82 now
reflect the specified configuration:

o Configuration: Active(Release)
o Platform: Active(x64)



o Project: AMP_TST_2305
o Configuration: Release
o Platform: x64
o Build: checked

Click on the ‘Apply’ button in the Property Pages window the click on ‘OK’. The project is now nearly
ready to build. Before building the APM DLL, the solution properties such as the specific compiler and
linker properties need to be set. This is covered in the following section.

6.4.3 Visual Fortran Solution Properties
Right click on the APM_TST_2305 solution folder in the Solution Explorer window. This opens the
solution Property Pages window shown in Figure 84.

Figure 84: Visual Studio Solution Property Pages Window

The ‘General’ configuration properties tab in Figure 84 shows that the configuration type is a
Dynamic link library and this setting cannot be changed. Most of the solution property settings
can be left in their default settings. For this demonstration example only the specific compiler
and linker settings are changed.



6.4.3.1 Compiler Settings
Expand the ‘Fortran’ compiler properties and set the various options as described below. Empty fields
are designated as < empty >.

General
o Suppress Startup Banner …………………………………………………………. Yes(/nologo)
o Additional Include Directories …………………………………………………. < empty >
o Debug Information Format ……………………………………………………… None
o Optimization ……………………………………………………………………………. Maximize Speed
o Preprocessor Definitions …………………………………………………………. < empty >
o Compile Time Diagnostics ……………………………………………………….. Custom

Optimization
o Optimization ……………………………………………………………………………. Maximize Speed
o Inline Function Expansion ……………………………………………………….. Any Suitable
o Favor Size or Speed …………………………………………………………………. Favor Fast Code
o Loop Unroll Count …………………………………………………………………… < empty >
o Parallelization: ………………………………………………………………………… No
o Threshold for Auto Parallelization ………………………………………….. 100
o Threshold for Vectorization ……………………………………………………. 100
o Prefetch Insertion ………………………………………………………………….. Disable
o I/O Buffering …………………………………………………………………………… No
o Heap Arrays …………………………………………………………………………….. < empty >
o Interprocedural Optimization …………………………………………………. No
o Enable Matrix Multiply Library Call …………………………………………. Default

Debugging
o Debug Information Format ……………………………………………………… None
o Enable Parallel Debug Checks ………………………………………………….. No
o Information for PARAMETER Constants ………………………………….. None (not selectable)

Preprocessor
o Preprocessor Source File …………………………………………………………. No
o Additional Include Directories …………………………………………………. < empty >
o Add Dependent Outputs to INCLUDE Path ……………………………… Yes
o Ignore Standard Include Path ………………………………………………….. No
o Default Include and Use Path ………………………………………………….. Source File Directory
o Preprocessor Definitions ………………………………………………………… < empty >
o Undefine Preprocessor Definitions ………………………………………… < empty >
o Undefine All Preprocessor Definitions ……………………………………. No
o Preprocessor Definitions to FPP Only ……………………………………… No
o OpenMP Conditional Compilation …………………………………………… Yes

Code Generation
o Enable Recursive Routines ………………………………………………………. No
o Generate Reentrant Code ………………………………………………………. Default
o Object Text String ……………………………………………………………………. < empty >



o Enable Enhanced Instruction Set …………………………………………….. Not Set
o Add Processor Optimized Code Path ……………………………………… None
o Intel Processor Specific Optimization ……………………………………… None

Language
o Source File Format …………………………………………………………………… Use File Extension
o Fixed Form Line Length ……………………………………………………………. 72 Columns
o Pad Fixed Form Source Lines …………………………………………………… No
o Enable Alternate PARAMETER Syntax …………………………………….. Yes
o Enable FORTRAN 66 Semantics ……………………………………………….. No
o Compile Lines With D in Column 1 …………………………………………… No
o Process OpenMP Directives …………………………………………………….. Disable
o Enable F2003 Semantics …………………………………………………………… No
o Enable Coarrays ……………………………………………………………………….. No
o MPI Configuration File ……………………………………………………………… < empty >
o Coarray Images ………………………………………………………………………… 0

Compatibility
o Unformatted File Conversion ………………………………………………….. None
o Enable VMS Compatibility ……………………………………………………….. No
o Enable F77 Run time Compatibility …………………………………………. No
o Use F77 Integer Constants ………………………………………………………. No
o Treat Backslash as Normal Character in Strings ……………………….. Yes
o Use Filenames from Command Line ………………………………………… No (PowerStation)
o Use PowerStation I/O Format …………………………………………………. No
o Use PowerStation Portability Library ……………………………………….. Yes
o Use PowerStation List Directed I/O Spacing …………………………….. No
o Use PowerStation Logical Values …………………………………………….. No
o Use Other PowerStation Run time Behavior …………………………… No

Diagnostics
o General

o Error Limit …………………………………………………………………… 30
o Treat Warnings As Errors ……………………………………………. No
o Warn For Non standard Fortran …………………………………. No
o Treat Fortran Standard Warnings As Errors ………………… No
o OpenMP Diagnostic Level …………………………………………… Default
o Auto Parallelizer Diagnostic Level ………………………………. Default
o Vectorizer Diagnostic Level ………………………………………… Default
o Disable Specific Diagnostics ……………………………………….. < empty >
o Emit Diagnostics to File ………………………………………………. No
o Diagnostics File …………………………………………………………… $(IntDir)\$(TargetName).diag

o Guided Auto Parallelism
o Guided Auto Parallelism Analysis ……………………………….. Disable
o Emit Guided Auto Parallelism Diagnostics to File ……….. No
o Guided Auto Parallelism Diagnostic File ……………………… $(IntDir)\$(TargetName).gap
o Guided Auto Parallelism Code Selection Options ……….. < empty >



o Language Usage Warnings
o Compile Time Diagnostics …………………………………………… Custom
o Warn For Undeclared Symbols …………………………………… No
o Warn For Unused Variables ………………………………………… No
o Warn When Removing %LOC ………………………………………. No
o Warn When Truncating Source Line ……………………………. No
o Warn For Unaligned Data ……………………………………………. Yes
o Warn For Uncalled Statement Function ……………………… No
o Suppress Usage Messages ………………………………………….. No
o Check Routine Interfaces ……………………………………………. No

o Optimization Diagnostics
o Optimization Diagnostic Level ……………………………………… Disable
o Emit Optimization Diagnostics to File ………………………….. No
o Optimization Diagnostic File ………………………………………… < empty >
o Optimization Diagnostic Phase ……………………………………. All optimizer phases
o Optimization Diagnostic Routine …………………………………. < empty >

o Static Analysis
o Level of Static Security Analysis …………………………………… None
o Analyze Include Files ……………………………………………………. No
o Static Security Analysis Results Directory ……………………. XE Results $(ProjectName)

Data
o Default Integer KIND ………………………………………………………………… 4
o Default Real KIND …………………………………………………………………….. 4
o Default Double Precision KIND …………………………………………………. 8
o Local Variable Storage ……………………………………………………………… Default Local Storage
o Initialize Local Saved Scalars to Zero ………………………………………… No
o Dynamic Common Blocks …………………………………………………………. < empty >
o Structure Member Alignment ………………………………………………….. Default
o Common Element Alignment …………………………………………………… None
o SEQUENCE Types Obey Alignment Rules …………………………………. No
o Assume Dummy Arguments Share Memory Locations ……………. No
o Assume CRAY Pointers Do Not Share Memory Locations ………… No
o Constant Actual Arguments Can Be Changed …………………………… No
o Use Bytes As RECL=Unit for Unformatted Files ………………………… No
o Initialize Stack Variables to an Unusual Value ………………………….. No

Floating Point
o Floating Point Exception Handling …………………………………………… Produce NaN, signed quantities
o Floating Point Model ……………………………………………………………….. Fast
o Reliable Floating Point Exceptions Model ………………………………… Default
o Extend Precision of Single Precision Constants ……………………….. No
o Enable IEEE Minus Zero Support ………………………………………………. No
o Limit COMPLEX Range ……………………………………………………………… No
o Check Floating Point Stack ………………………………………………………. No
o Floating Point Speculation ………………………………………………………. Fast



External Procedures
o Calling Convention …………………………………………………………………… Default
o Name Case Interpretation ……………………………………………………….. Default
o String Length Argument Passing ………………………………………………. After All Arguments
o Append Underscore to External Names ………………………………….. No

Output Files
o Module Path ……………………………………………………………………………. $(IntDir)\
o Object File Name …………………………………………………………………….. $(IntDir)\
o Program Database File Name ………………………………………………….. $(IntDir)\vc100.pdb
o Assembler Output …………………………………………………………………… No Listing
o ASM Listing Name ……………………………………………………………………. $(IntDir)\ (not selectable)
o Source Listing …………………………………………………………………………… No
o Source Listing File …………………………………………………………………….. $(IntDir)\$(InputName).lst
o Build Dependencies …………………………………………………………………. No
o Emit Build Dependencies to File ………………………………………………. No
o Build Dependencies File …………………………………………………………… $(IntDir)\$(InputName).dep

Run time
o Generate Traceback Information …………………………………………….. No
o Default Output Carriage Control ………………………………………………. Default
o Runtime Error Checking ……………………………………………………………. Custom
o Check For Null Pointers and Allocatable Array References ………. No
o Check for Array and String Bounds …………………………………………… No
o Check Uninitialized Variables …………………………………………………… No
o Check Edit Descriptor Data Type ………………………………………………. No
o Check Edit Descriptor Data Size ……………………………………………….. No
o Check for Actual Arguments Using Temporary Storage …………… No

Libraries
o Runtime library ………………………………………………………………………… Multithread DLL (libs:dll /threads)
o Use Common Windows Libraries ……………………………………………… No
o Use Portlib Library ……………………………………………………………………. No
o Use Intel Math Kernel Library ………………………………………………….. No
o Disable Default Library Search Rules ……………………………………….. No
o Disable OBJCOMMENT Library Names in Object …………………….. No

Command Line

/nologo /module:”x64\Release\\” /object:”x64\Release\\” /Fd”x64\Release\vc100.pdb”
/libs:dll /threads /c



6.4.3.2 Linker Settings
Expand the ‘Linker’ properties and set the various options as described below. Empty fields are
designated as < empty >. In this example the DLL is assigned a 100 MByte stack size.

General
o Output File …………………………………………………………………. $(OutDir)\$(ProjectName).dll
o Show Progress ……………………………………………………………. Not Set
o Version ………………………………………………………………………… < empty >
o Enable Incremental Linking …………………………………………. Default
o Suppress Startup Banner ……………………………………………. Yes (/NOLOGO)
o Ignore Input Library ……………………………………………………. No
o Register Output ………………………………………………………….. No
o Per user Redirection …………………………………………………… No
o Additional Library Directories ……………………………………… < empty >
o Link Library Dependencies …………………………………………. Yes

Input
o Additional Dependencies …………………………………………… < empty >
o Ignore All Default Libraries …………………………………………. No
o Ignore Specific Library ………………………………………………… < empty >
o Module Definition File ………………………………………………… < empty >
o Add Module to Assembly …………………………………………… < empty >
o Embed Managed Resource File …………………………………… < empty >
o Force Symbol References …………………………………………… < empty >
o Delay Loaded DLLs ………………………………………………………. < empty >

Manifest File
o Generate Manifest ……………………………………………………… Yes
o Manifest File ……………………………………………………………….. $(TargetPath).intermediate.manifest
o Additional Manifest Dependencies ……………………………. < empty >
o Allow Isolation ……………………………………………………………. Yes
o Enable User Account Control (UAC) ………………………….. Yes
o UAC Execution Level ………………………………………………….. asInvoker
o UAC Bypass UI Protection ………………………………………….. No

Debugging
o Generate Debug Info …………………………………………………. No
o Generate Program Database File ………………………………. $(TargetDir)$(TargetName).pdb
o Strip Private Symbols …………………………………………………. < empty >
o Generate Map File …………………………………………………….. No
o Map File Name ………………………………………………………….. < empty >
o Map Exports ………………………………………………………………. No
o Debuggable Assembly ……………………………………………….. No Debuggable attribute emitted

System
o SubSystem …………………………………………………………………. Windows (/SUBSYSTEM:WINDOWS)
o Heap Reserve Size ……………………………………………………… 0



o Heap Commit Size ………………………………………………………. 0
o Stack Reserve Size ………………………………………………………. 104857600
o Stack Commit Size ………………………………………………………. 104857600
o Enable Large Addresses ……………………………………………… Default
o Terminal Server ………………………………………………………….. Default
o Swap Run from CD ……………………………………………………… No
o Swap Run from Network ……………………………………………. No

Optimization
o General

o References …………………………………………………….. Default
o Enable COMDAT Folding ……………………………….. Default
o Optimize for Windows98 ………………………………. Default
o Function Order ………………………………………………. < empty >

o Whole Program Optimization
o Interprocedural Optimization ……………………….. Yes
o Assembler Output …………………………………………. No Listing
o Assembler Output Listing Name/Location ……. < empty >
o Object File Name …………………………………………… < empty >

Embedded IDL
o MIDL Command File …………………………………………………… < empty >
o Ignore Embedded IDL ………………………………………………… No
o Merged IDL Base File Name ……………………………………….. < empty >
o Type Library ………………………………………………………………… < empty >
o Typelib Resource ID ……………………………………………………. 1

Advanced
o Entry Point ………………………………………………………………….. < empty >
o Resource Only DLL ………………………………………………………. No
o Set Checksum …………………………………………………………….. No
o Base Address ……………………………………………………………… < empty >
o Fixed Base Address ……………………………………………………. Default
o Turn Off Assembly Generation ………………………………….. No
o Support Unload of Delay Loaded DLLs ……………………….. No
o Import Library ……………………………………………………………… $(TargetDir)$(TargetName).lib
o Merge Sections …………………………………………………………… < empty >
o Target Machine ………………………………………………………….. Not Set

Command Line

/OUT:”x64\Release\APM_TST_2305.dll” /NOLOGO /MANIFEST /MANIFESTFILE:”C:\APM_TST_2305\
APM_TST_2305\APM_TST_2305\x64\Release\APM_TST_2305.dll.intermediate.manifest”
/MANIFESTUAC:”level=’asInvoker’ uiAccess=’false’” /SUBSYSTEM:WINDOWS
/STACK:104857600,104857600
/IMPLIB:”C:\APM_TSTS_2305\APM_TST_2305\APM_TST_2305\x64\Release\
APM_TST_2305.lib” /DLL

100 Mbyte stack
reserve and
commit size
specified as
decimal value.



6.4.4 Building the Solution
To build the APM DLL, click on Build >Build Solution in Visual Studio. The output window displays
messages as each source file is compiled. The DLL module APM_TST_2305.dll is generated in the
x64/Release directory which also contains various other output files. At this point the DLL file can be
renamed as required (e.g. APM2305_100MB_x64.dll) to give it a more descriptive name and copied to
the MiDLE APM folder.

Figure 85: Building the Solution in Visual Studio

6.5 An Example Scenario
The following sections provide a step by step example in which MiDLE is used to execute a new
scenario. In this example the radar platform’s location is changed to a new location and a new missile
launch position is designated. The missile follows a new trajectory to the target performing a single
radius turn. MiDLE then executes the required calculations and displays the probability of detection
information.

This example assumes that the software was successfully configured and installed on a computer
platform as explained in Section 5.



6.5.1 Launching MiDLE
First launch MiDLE in either the IDL development environment or run time environment. The view
appears as shown in Figure 86.

Figure 86: Example Scenario – The MiDLE Display

MiDLE can be started from the IDL DE by typing ‘midle_init’ at the command line. In the RT environment
it can be started by double clicking the ‘MiDLE_V6.exe’ program then clicking on the IDL splash screen.

6.5.2 Repositioning the Radar Platform
Reposition the radar platform by clicking on Parameters >Radar in the top level menu. This opens the
Radar Parameters Control (RPC) panel. Click the cursor at the approximate position of 63.988 longitude
and 44.603 latitude (west of the default location) while holding down the <Alt> key. The RPC panel will
update showing the new position selected as shown in Figure 87.

Figure 87: Example Scenario – Repositioning the Radar Platform

0 43.6 76.0 63.988342 44.602833



Click the APPLY button in the RPC panel. The view takes a few seconds to update as new elevation data
files are loaded and will appear as shown in Figure 88. Close the RPC panel and zoom in on the view to
display a range of about 30 km.

Figure 88: Example Scenario – View of New Radar Location

6.5.3 Specifying NewMissile Waypoints
From the top level menu select Parameters Missile. The Missile Parameters Control panel appears
containing two waypoints showing the missile launch location and the target location. The program sets
the target location by default to that of the radar platform, however the missile launch location is
unknown at this time and the default launch location is used. The view appears as shown in Figure 89.
(The MPC panel was moved to the left hand side).

Figure 89: Example Scenario – Default Missile Waypoints

Click on waypoint #0 in the waypoint table and specify a new missile launch position. Hold down the
<Shift> key and click anywhere in the view and the lat/lon values automatically updated in the table.
Recall that the current radar scan is from 270° to 0° so make sure the waypoints are located in this
quadrant. (The radar scan region can be modified using the RCP panel). Figure 90 shows the view with
the new missile launch position designated. The height above sea level of the new waypoint is shown by
the cursor.

Default missile
launch position



Figure 90: Example Scenario – New Missile Launch Point

Modify the corresponding entry in the table so that the missile height is ‘above’ this elevation.

The line connecting the launch and destination (target) waypoints is not entirely visible, indicating that
at certain points there is intervening terrain. Additional waypoints have to be added so that the missile
either flies over land features or around them.

To add a new waypoint, select the waypoint after which a new one is to be inserted and click on the
INSERT button. Hold down the <Shift> key and click in the view to designate its location. This procedure
can be repeated until a satisfactory waypoint is found. To add another waypoint after the new one,
select the new one and click INSERT again, etc. Figure 91 shows the final waypoint configuration.

While designating the waypoints, the MiDLE view can be zoomed, translated or rotated for a better
perspective. The MPC panel is a floating widget that will always stay above the view.

Figure 91: Example Scenario – Final Waypoint Configuration

New missile
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Press APPLY after the missile waypoints have been successfully configured to apply them to the current
session. At this point the Display >Threat >Trajectory is disabled as the new trajectory has not yet been
calculated. Close the MPC panel. The missile waypoints and the lines connecting them are removed
from the view.

6.5.4 Setting the Program Execution Control Parameters
Select Program >Control to open the Program Execution Control panel. The panel appears as shown in
Figure 92.

Figure 92: Example Scenario – Program Execution Control Panel

The scenario name entry is ‘default’ as it has not yet been specified. Enter ‘example’ and press <Return>
which updates all filenames used by the program. Note that MiDLE automatically selects the trajectory,
missile propagation, missile range weights, surface clutter power and detection thresholds and
probability calculations (indicated in Figure 92 by arrows) to be executed. These quantities, as a
minimum, must be calculated when new missile/projectile waypoints are specified. The other quantities
used are taken from the defaults. The user can of course opt to execute the refractivity profile, terrain
and other calculations as well.



Click on APPLY to apply the selections to the current scenario. Clicking on the ‘S’ button adjacent to
each quantity opens a file dialog box where the user can specify a different filename to be saved or
restored. Close the Program Execution panel.

6.5.5 Running MiDLE
Click on Program >Start. MiDLE will start and open the popup dialog box shown in Figure 93.

Figure 93: Example Scenario – MiDLE Execution Dialog Box

The dialog box show that MiDLE is operating in ‘normal’ mode as opposed to batch processing mode.
Click on ‘Yes’ to start program execution.

The program displays various messages in the system message window while it is running. When
parallelized procedures are executed MiDLE spawns slave processes whose status windows appear on
the upper left portion of the screen. The following Figure 94 shows the slave process status windows for
the missile range weights calculations.

The user can optionally kill slave processes, for example if the program needs to be terminated for some
reason. If a slave process is killed, MiDLE will terminate all other slave processes automatically and issue
a warning message. MiDLE will continue to run and the user can access all program controls from the
menus.

Figure 94: Example Scenario – Slave Process Status Windows



6.5.6 Calculation Results
When MiDLE finishes calculations, the main view is updated with probability of detection information.
Figure 95 shows the results.

Figure 95: Example Scenario – Calculation Results

From the above figure it can be seen that the missile will be detected with a high probability
immediately after it is launched. The probability of detection drops to zero for a brief period then
increases again.

Taking a look at the probability of detection plot using Plot >Probability of detection, it can be seen that
there is good agreement with the visual presentation of the data.

Figure 96: Example Scenario – Probability of Detection Plot



Appendix A Diagnostic File Example

*******************************************************************************************
*** MiDLE Runtime Diagnostics Output *** 
    Date: Tue Mar 12 21:12:08 2013 
    Operating mode:  Normal 

PARAMETERS:
                    rad.SCANAZ               scalar                      1.57080      float 
                      rad.BSAZ               scalar                  0.026087436     double 
                     rad.PHBAI               scalar                      4.71239      float 
                       rad.THC               scalar                      1.57080      float 
                      rad.THBS               scalar                    1.3089969     double 
                      rad.PHBS               scalar                    5.4977871     double 
                       rad.GBS             [1 x 20]                                  double 
                    rad.NBURST               scalar                            4       long 
                       rad.TH3             [1 x 20]                                  double 
                       rad.PH3             [1 x 20]                                  double 
                     rad.BURST             [1 x 20]                                  struct 
                 rad.ANTDIAMPH               scalar                      1.00000      float 
                 rad.ANTDIAMTH               scalar                      1.00000      float 
                        rad.HA               scalar                    28.000000     double 
                      rad.RRES               scalar                    37.474998     double 
                       rad.TAU               scalar                 5.00000e-005      float 
                      rad.LONR               scalar                   -63.988342     double 
                      rad.LATR               scalar                    44.602833     double 
                       rad.POL               scalar                            V     string 
                         rad.N               scalar                      200.000      float 
                        rad.PT               scalar                      13000.0      float 
                        rad.LS               scalar                      1.00000      float 
                        rad.FN               scalar                      5.62341      float 
                        rad.BR               scalar                    4000000.0     double 
                        rad.BN               scalar                    5000000.0     double 
        rad.FREQUENCYWEIGHTING               scalar                       Taylor     string 
                       rad.DSL               scalar                     -40.0000      float 
                      rad.NBAR               scalar                            6    integer 
                        rad.GS               scalar                     0.000000      float 
                    rad.STCEXP               scalar                            3    integer 
                 rad.STCOFFSET               scalar                     0.000000      float 
               rad.STCMAXRANGE             [1 x 20]                                  double 
                        rad.TO               scalar                      290.000      float 
                    rad.SATLEV               scalar                      69.0000      float 
       rad.TIMEDOMAINWEIGHTING               scalar                      Hanning     string 
                     rad.NFILL               scalar                            1       long 
                  rad.SCANTYPE               scalar                           EE     string 
         rad.THGAINPATTERNTYPE               scalar                       sinx/x     string 
                      rad.ARPM               scalar                      30.0000      float 
      rad.PULSECOMPRESSIONTYPE               scalar                          LFM     string 
         rad.PHGAINPATTERNTYPE               scalar                       sinx/x     string 
rad.ANTENNASIDELOBESUPPRESSION              [1 x 2]                                  string 
      rad.ANTENNASIDELOBELEVEL              [1 x 2]                                   float 
                 rad.PHASECODE            [1 x 150]                                 integer 
             rad.PHASECODE_LEN               scalar                           35    integer 
                     rad.FSAMP               scalar                    4000000.0     double 
             rad.THUSERPATTERN         [20 x 2 x 7]                                   float 
                     con.RSTEP               scalar                    37.474999     double 
                  con.MAXRANGE               scalar                      50000.0      float 
                  con.NPERPEAK               scalar                           11    integer 
              con.MAXPROPANGLE               scalar                      10.0000      float 
                      con.DRF2               scalar                      100.000      float 
                      con.DHF2               scalar                      1.00000      float 
                con.DPATHANGLE               scalar                 0.0062831853     double 
                con.HPACLEVELS               scalar                           10    integer 
                    con.REFRDR               scalar                      1000.00      float 
           con.LWKDMEASHEIGHTU               scalar                      1.50000      float 
          con.LWKDMEASHEIGHTWS               scalar                      10.0000      float 
               con.TEST2THRESH               scalar                   0.00500000      float 
                        con.H2               scalar                      30.0000      float 
                   con.MAXITER               scalar                          200    integer 



           con.AZBEAMSHAPELOSS               scalar                            0    integer 
                    con.DPHINT               scalar                 0.0065217390     double 
            con.AZPERBEAMWIDTH               scalar                      4.00000      float 
                       con.DPL               scalar                     0.990000      float 
                 con.RANGEFOLD               scalar                            2    integer 
      con.NUMPOINTSINBEAMWIDTH               scalar                            5    integer 
                 con.THMIN4INT               scalar                    0.0174533      float 
                      con.NSPG               scalar                         1000    integer 
          con.SAMPLELIMITVALUE               scalar                    2500000.0     double 
                  con.W2POINTS               scalar                          101    integer 
                con.APM_MAX_NH               scalar                         1000    integer 
                      con.NCPU               scalar                            2       long 
                  con.CALLPATH               scalar         C:\MiDLE\MiDLEV6\V6\     string 
                con.TARGETTYPE               scalar                      Missile     string 
                 con.PROPMODEL               scalar                          APM     string 
                 con.APMMETHOD               scalar                          dll     string 
               con.BLENDMETHOD               scalar                         DRDC     string 
                    con.DBLEND               scalar                     0.250000      float 
             con.LWKDMAXHEIGHT               scalar                      50.0000      float 
                  con.PDTHRESH               scalar                     0.900000      float 
                       env.SOL               scalar               2.9980000e+008     double 
                        env.RE               scalar                    6371000.0     double 
                        env.SS               scalar                            5    integer 
      env.TERRAINELEVATIONFILE               scalar     TerrainElevationFile.dat     string 
                    env.LCTYPE             [2 x 28]                                  string 
                       env.VWS               scalar                      11.4401      float 
                        env.TS               scalar                      15.0000      float 
                       env.RHS               scalar                      90.0000      float 
                        env.PS               scalar                      1013.25      float 
                        env.RV               scalar                      461.500      float 
       env.REFRACTIVITYPROFILE            [3 x 155]                                   float 
env.REFRACTIVITYPROFILE_NOHPAC              [3 x 9]                                   float 
                   env.PHIWIND               scalar                      3.66519      float 
                  env.REFTABLE    [2 x 5 x 30 x 12]                                   float 
                        env.KB               scalar               1.3800000e-023     double 
                 env.LOGATABLE        [2 x 30 x 12]                                   float 
                   env.AWTABLE        [2 x 30 x 12]                                   float 
                      env.THSW               scalar                      3.66519      float 
               env.RDCACFACTOR             [1 x 12]                                   float 
                  env.VWS_LAND               scalar                      3.15686      float 
                  env.HPACFILE               scalar   hpac2005091612_000_011.txt     string 
                  env.HPACFLAG               scalar                           12    integer 
                  env.HPACTIME               scalar     Fri Sep 16 14:04:05 2005     string 
                env.RRCONSTANT               scalar                      20.0000      float 
                      env.HMAX               scalar                      10000.0      float 
                 env.ZEPROFILE              [2 x 7]                                   float 
                  env.ZESOURCE               scalar                           3D     string 
                   env.SRCAPPI               scalar           200509171450PRECIP     string 
                    env.CAPPI1               scalar           200509171450CAPPI1     string 
                    env.CAPPI4               scalar           200509171450CAPPI4     string 
                  env.ECHOTOPS               scalar          200509171450ECHOTOP     string 
                     env.HRESZ               scalar                      500.000      float 
                       env.ETZ               scalar                      18.0000      float 
                      env.DZDH               scalar                  -0.00700000      float 
                        env.KE               scalar                      1.33333      float 
                        env.PW               scalar                 1.00000e+006      float 
                        env.AA               scalar                      200.000      float 
                        env.BB               scalar                      1.60000      float 
                       env.KW2               scalar                     0.920000      float 
                     env.EULER               scalar                     0.557216      float 
                      env.SIGT               scalar                      1.00000      float 
                env.VWCONSTANT               scalar                      11.4400      float 
           env.PHIWINDCONSTANT               scalar                      3.66519      float 
                 env.VWPROFILE              [3 x 4]                                   float 
                env.WINDSOURCE               scalar                           3D     string 
                         env.G               scalar                     -9.80665      float 
                env.WAVESOURCE               scalar                           2D     string 
                  env.WAVEFILE               scalar         2005091612_000.grib1     string 
                       env.HAV               scalar                      2.00000      float 
                       env.SAL               scalar                      30.0000      float 
          env.WAVEFORECASTHOUR               scalar                            2    integer 



             env.LANDCOVERFLAG               scalar                            1    integer 
              env.LANDCOVERALL               scalar                           25    integer 
              env.PROFILEMERGE               scalar                            1    integer 
                 env.MOPROFILE               scalar                            0    integer 
               env.UPPERHEIGHT               scalar                      20.0000      float 
                    env.UPPERP               scalar                      996.700      float 
                    env.UPPERT               scalar                      31.1000      float 
                   env.UPPERRH               scalar                      77.0000      float 
                  env.WSHEIGHT               scalar                      20.0000      float 
                      env.WSPD               scalar                      5.20000      float 
                      env.WDIR               scalar                      320.000      float 
                      env.TSEA               scalar                      33.9000      float 
               env.LOWERHEIGHT               scalar                     0.000000      float 
                   env.LOWERRH               scalar                      98.2000      float 
           env.GROUNDELEVATION               scalar                     0.000000      float 
                  env.UPPERAIR             [4 x 24]                                   float 
                  env.DEDLEVEL               scalar                            1     string 
                 env.VONKARMON               scalar                     0.400000      float 
                        env.PO               scalar                      1000.00      float 
                        env.RD               scalar                      287.000      float 
                        env.CP               scalar                      1004.67      float 
                     env.ALPHA               scalar                    0.0110000      float 
                       env.FCP               scalar                      1.25000      float 
                      env.RHWS               scalar                      100.000      float 
              mis.START_LONLAT              [1 x 2]                                  double 
                     mis.LONMI            [1 x 200]                                  double 
                     mis.LATMI            [1 x 200]                                  double 
                       mis.HMI            [1 x 200]                                  double 
                       mis.VMI            [1 x 200]                                  double 
                       mis.MCA               scalar                    48.999996     double 
                 mis.RCSSOURCE               scalar                       Aspect     string 
                   mis.RCSFILE               scalar     RCS_Exocet_9.0GHz_vv.dat     string 
                      mis.RCSI               scalar                     0.100000      float 
                  mis.SWERLING               scalar                            3    integer 
                     mis.MTLON               scalar                   -63.988342     double 
                     mis.MTLAT               scalar                    44.602833     double 
                   mis.LONMI_P            [1 x 200]                                  double 
                   mis.LATMI_P            [1 x 200]                                  double 
                    prj.PL_LON               scalar                   -63.624161     double 
                    prj.PL_LAT               scalar                    44.749537     double 
             prj.PL_HEIGHT_AGL               scalar                            4    integer 
                      prj.PL_V               scalar                      1000.00      float 
                    prj.PD_LON               scalar                   -63.453902     double 
                    prj.PD_LAT               scalar                    44.508437     double 
                 prj.RCSSOURCE               scalar                     Constant     string 
                      prj.RCSI               scalar                     0.100000      float 
                        sig.LD               scalar                      1.00000      float 
                  sig.DWELLPFA               scalar               1.0000000e-006     double 
                       sig.PFA               scalar                0.00040835946     double 
                         sig.M               scalar                            2    integer 
                       sig.MTI               scalar                            1    integer 
            sig.PROCESSINGTYPE               scalar                          FFT     string 
              sig.DETECTORTYPE               scalar                   square-law     string 
                       jam.PTJ               scalar                      1200.00      float 
                       jam.GTJ               scalar                      39.8107      float 
                       jam.FTJ               scalar               8.9550000e+009     double 
                        jam.BJ               scalar                    4000000.0     double 
        jam.PHGAINPATTERNTYPEJ               scalar                       sinx/x     string 
        jam.THGAINPATTERNTYPEJ               scalar                       sinx/x     string 
                      jam.LONJ               scalar                   -63.624161     double 
                      jam.LATJ               scalar                    44.749537     double 
                      jam.PH3J               scalar                     0.349066      float 
                      jam.TH3J               scalar                     0.349066      float 
                jam.ANTDIAMPHJ               scalar                     0.100000      float 
                jam.ANTDIAMTHJ               scalar                     0.100000      float 
                     jam.PHBSJ               scalar                    3.1415926     double 
                      jam.THCJ               scalar                      1.57080      float 
                       jam.HAJ               scalar                      100.000      float 
                      jam.POLJ               scalar                            V     string 
                      ext.V101               scalar                            0    integer 
                 ext.V2ECLIPSE               scalar                            0    integer 



                   ext.WALLOPS               scalar                            0    integer 
                     ext.IDATA               scalar                            0    integer 
                      ext.SADM               scalar                            0    integer 
                ext.ANGLELIMIT               scalar                            1    integer 
                    ext.GENKML               scalar                            0    integer 
                    ext.OLDLEC               scalar                            1    integer 
                    ext.SAVEIQ               scalar                            0    integer 
                 ext.IQ_OLDLPH               scalar                            1    integer 
                 ext.IQ_OLDSUM               scalar                            1    integer 

PROGRAM EXECUTION CONTROL FLAGS: 
               gOldMissilePath              0 
              gOldRefractivity              1 
              gNoPrecipitation              1 
                   gOldTerrain              1 
                         gV101              0 
       gOldClutterRangeWeights              1 
                    gV2eclipse              0 
               gOldPropagation              1 
                      gWallops              0 
                        gOldWC              1 
                     gOldLphWC              1 
                     gOldLthWC              1 
                        giData              0 
        gOldMissilePropagation              0 
                 gOldMissileW2              0 
                       gOldLec              1 
                     gOldLphSC              1 
                       gOldSum              0 
                         gSADM              0 
                     gNoJammer              1 
                    gOldJammer              1 
                    gOldThProb              0 
                       gSaveIQ              0 
                    gIQ_OldSum              1 
                    gIQ_OldLph              1 

PROGRAM DATA FILES: 
           gTrajectoryDataFile                  MissilePath_example.dat 
         gRefractivityDataFile                            M_example.dat 
              gTerrainDataFile                      Terrain_example.dat 
    gClutterRngWeightsDataFile          ClutterRangeWeights_example.dat 
          gPropagationDataFile           ExtractedSurfaceF4_example.dat 
         gReflectivityDataFile                          dbz_example.dat 
          gMissilePropDataFile                  MissileF4th_example.dat 
    gMissileRngWeightsDataFile          MissileRangeWeights_example.dat 
        gEclipsingLossDataFile                          Lec_example.dat 
            gWC3DPowerDataFile               WeatherClutter_example.dat 
            gWC1DPowerDataFile               WeatherClutter_example.dat 
            gWC0DPowerDataFile               WeatherClutter_example.dat 
    gWCAzBeamshapeLossDataFile        WCAzBeamshapeLossData_example.dat 
    gWCElBeamshapeLossDataFile        WCElBeamshapeLossData_example.dat 
               gSCAzRngSumFile                          Sum_example.dat 
    gSCAzBeamshapeLossDataFile        SCAzBeamshapeLossData_example.dat 
          gJammerPowerDataFile                       Jammer_example.dat 
               gIQAzRngSumFile                          Sum_example.dat 
    gIQAzBeamshapeLossDataFile        IQAzBeamshapeLossData_example.dat 
           gThreshProbDataFile                   ThreshProb_example.dat 

PROGRAM EXECUTION LOG: 
Starting MiDLE.. 
Calculating missile flight path.. 
Duration: 26.95 seconds. 
Saving file C:\MiDLE\MiDLEV6\V6\OUTPUT\MissilePath_example.dat.. 
       variables:  rpath phpath thpath vpath max_tta lonr latr 
Displaying threat trajectory.. 
Calculating scanning characteristics.. 
Duration: 0.69 seconds. 
Restoring refractivity profiles file.. 
File "C:\MiDLE\MiDLEV6\V6\OUTPUT\M_example.dat" was not found.  Using default.. 
Restoring terrain properties file.. 



File "C:\MiDLE\MiDLEV6\V6\OUTPUT\Terrain_example.dat" was not found.  Using default.. 
Restoring range weighting functions file.. 
File "C:\MiDLE\MiDLEV6\V6\OUTPUT\ClutterRangeWeights_example.dat" was not found.  Using default.. 
Restoring propagation file.. 
File "C:\MiDLE\MiDLEV6\V6\OUTPUT\ExtractedSurfaceF4_example.dat" was not found.  Using default.. 
Calculating missile trajectory.. 
Duration: 0.51 seconds. 
Calculating missile RCS for each missile position.. 
Duration: 0.02 seconds. 
Saving file C:\MiDLE\MiDLEV6\V6\OUTPUT\MissileRCS.dat.. 
       variable:  rcs 
Processing missile I and Q signals.. 
Duration: 165.88 seconds. 
Performing missile power limiting.. 
Duration: 0.12 seconds. 
Calculating surface clutter power.. 
File C:\MiDLE\MiDLEV6\V6\OUTPUT\ExtractedSurfaceF4_example.dat was not found.  Using default.. 
File C:\MiDLE\MiDLEV6\V6\OUTPUT\ClutterRangeWeights_example.dat was not found.  Using default.. 
Duration: 172.03 seconds. 
Calculating receiver system mean noise power.. 
Duration: 0.00 seconds. 
Calculating detection thresholds and probabilities.. 
Duration: 430.58 seconds. 
Saving file C:\MiDLE\MiDLEV6\V6\OUTPUT\ThreshProb_example.dat.. 
       variables:  np threshold Pd_intlim MDP fdindex 
Calculating dwell probability of detection.. 
Duration: 0.00 seconds. 
Limiting output data for each illumination.. 
Saving file C:\MiDLE\MiDLEV6\V6\OUTPUT\MissilePath_example_PlotQty.dat 
       variables:  env rad con rm thm phm vrm timem rcs mF4th Pdd 
                   trimI trimQ Pn Pd_maxindex rcint F4th trimF4th 
                   rc PrSC phba trimPrSC rpath thpath phpath ranges 
                   Pd Pddu PWc phq ref hsig Mdata MaxBinRange terr WindData 
MiDLE completed!  Total elapsed time: 811.50 seconds  (13.5 minutes). 



Appendix B – APM Version 2.3.05 Fortran Source Files
APM filename Date modified Size (KB)

aln_init.f90 24/08/2004 2
antpat.f90 21/03/2006 6
apm_mod.f90 17/09/2008 58
apmclean.F90 08/08/2008 9
apmfuncs.f90 08/08/2008 20
apminit.f90 08/08/2008 29
apmmain_mod2.f90 28/11/2012 32
apmstep.f90 08/08/2008 9
apmsubs.f90 08/08/2008 18
calclos.f90 08/01/2007 15
clutter.f90 31/01/2007 12
dieinit.F90 13/12/2006 11
doshift.F90 08/12/2005 2
exto.F90 24/03/2006 11
fedr.F90 07/08/2007 7
fem.F90 07/08/2007 9
fft.F90 08/12/2005 2
FFT42.F90 11/07/2006 4
FFT42_32.F90 07/02/2012 4
fftpar.F90 05/12/2006 3
fillht.F90 27/03/2006 5
frstp.F90 08/12/2005 2
fzlim.F90 08/08/2008 4
gas abs.F90 08/12/2005 2
get_k.F90 19/12/2005 6
getaln.f90 26/08/2004 5
getangles.f90 08/08/2008 8
getrefcoef.f90 02/12/2005 5
gettheta.F90 08/12/2005 2
getthmax.f90 08/08/2008 13
graze_int.F90 24/08/2007 9
htcheck.F90 24/08/2007 4
intprof.F90 08/12/2005 2
meanfilt.F90 19/07/2006 2
mixedft.f90 03/11/2005 5
peinit.f90 08/08/2008 7
pestep.f90 25/11/2012 12
process_ang.F90 20/08/2007 15
profref.F90 08/12/2005 4
raytrace.F90 08/12/2005 9
refinit.F90 08/08/2007 14
refinter.F90 08/12/2005 4
remdup.F90 02/02/2006 2



APM filename Date modified Size (KB)

ret_graze.F90 05/06/2006 4
rgtace.F90 14/08/2007 7
rocalc.F90 08/08/2008 10
roloss.F90 08/08/2007 14
savepro.F90 08/12/2005 2
sort2.F90 08/08/2007 2
specest.F90 08/12/2005 4
spm.f90 08/08/2008 18
surfimp.f90 26/08/2004 6
terinit.F90 12/12/2006 7
trace_rout.F90 08/08/2008 5
trace_step.F90 20/08/2007 6
tropoinit.f90 19/12/2005 4
troposcat.f90 02/11/2005 5
xoinit.F90 30/01/2007 4
xostep.F90 14/12/2006 7
xyinit.F90 08/12/2005 3



Appendix C – Acronyms and Abbreviations

APM Advanced Propagation Model
BMP Bulk Meteorological Parameters
CAPPI Constant Altitude Plan Position Indicator
CCS Contour Colours Selection
CD Compact Disk
CDED Canadian Digital Elevation Data
CPC Control Parameters Control
CPF Canadian Patrol Frigate
CPU Central Processing Unit
DE Development Environment
DLL Dynamically Linked Library
DRDC Defence Research and Development Canada
DTED Digital Terrain Elevation Data
EPC Environment Parameters Control
EXPC Expert Parameters Control
FFT Fast Fourier Transform
GEM Global Environment Multiscale
GUI Graphical User Interface
HPAC Hazard Prediction Assessment Capability
IDL Interactive Design Language
JPC Jammer Parameters Control
KML Keyhole Markup Language
MiDLE Missile Detection in the Littoral Environment
MPC Missile Parameters Control
MPI Message Passing Interface
MS Microsoft
MTI Moving Target Indicator
NSWC Naval Software Weapons Center
PD Probability of Detection
PEC Program Execution Control
PF Propagation Factor
PRM Power Received from Missile
PPC Projectile Parameters Control
RPC Radar Parameters Control
RCS Radar Cross Section
RT Run Time
SCP Surface Clutter Power
SM Shared Memory
SPF Save Parameters File
SPPC Signal Processing Parameters Control
STC Sensitivity Time Control
SUM Software User Manual
WCP Weather Clutter Power
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